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About this manual

This manual covers the installation, configuration, and administration of the
GatorBox software (GatorSystem, GatorPrint, and GatorShare). The
GatorBox software can run on the GatorBox, GatorBox CS, GatorMIM CS,
and GatorBox CS/Rack hardware platforms. The material covered in each
chapter is outlined below.

The term GatorBox is used to refer to all models of the GatorBox
(GatorBox, GatorBox CS, GatorMIM CS and GatorBox CS/Rack). When it is
necessary to distinguish between them, the model name will be used.

p Chapter 1 presents an overview of the GatorBox hardware and
software and describes GatorKeeper, the application you use to
configure and manage the GatorBox.

p Chapter 2 describes how to install and use GatorKeeper.

» Chapter 3 describes how to configure and use your GatorBox for
TCP/IP services, such as terminal emulation or NCSA Telnet.

p Chapter 4 describes how to configure and use your GatorBox as an
AppleTalk router.

» Chapter 5 describes how to configure and use your GatorBox as a
DECnet router.

» Chapter 6 describes how to configure and use your GatorBox for
UNIX-to-LocalTalk printing. You will receive this chapter if you
purchase the GatorPrint or GatorShare software.

» Chapter 7 describes how to configure and use your GatorBox for
AppleShare-to-NFS file sharing. You will receive this chapter if you
purchase the GatorShare software.

GatorBox User’s Guide About this manual
August 1991 ix



Who should read this manual

p Chapter 8 describes the GatorKeeper tools you can use to monitor and
administer your GatorBox once it has been configured.

» Appendix A provides a checklist of configuration information you
need before you begin configuring your GatorBox.

» Appendix B provides information on how to convert files created using
an earlier version of GatorShare to Release 2.0 filename mapping. You
will receive this Appendix if you purchase the GatorShare software.

Who should read this manual

This manual is intended for network administrators responsible for setting
up and maintaining the GatorBox software.

If you are unfamiliar with the concepts presented in this manual, refer to the
m GatorBox Reference.

Documentation conventions
This manual uses certain conventions in presenting information:
» Menu commands and button names appear in italic sans serif type
face; for example:
Choose Save from the File menu to save the GatorBox configuration
information.

p Computer display text appears in Courier type face; for example:

The syntax for the group file is:

sales:*:14:jane, sandy, kim, peter, josiah
other:*:16: )
marketing:*:17:andy,chris,michael, karen
ga:*:99:james, harry,ellen

» User-entered text appears in bold Courier; for example:

zone=-marketing

About this manual GatorBox User’s Guide
b 4 August 1991
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Related Documentation

< » The term GatorBoxX is used to refer to all models of the GatorBox
(GatorBox, GatorBox CS, GatorMIM CS and GatorBox CS/Rack). When
it is necessary to distinguish between them, the model name will be
used. '

Icon conventions

Icons are used for points of special interest as follows:

Araised hand indicates Caution information. You should not proceed
until you read and understand the Caution message.

An exclamation polint indicates an Alert. It provides additional
information that you may need before you proceed.
A talking head indicates Note information. Notes provides additional or

supplementary information about an activity or concept.

A book indicates a Cross-Reference. Cross-references point to
information in other manuals that may be useful to understanding an
activity or concept.

An original GatorBox icon is a note that describes features or
functionality specific to the original GatorBox.

Related Documentation

For information on setting up the GatorBox hardware, refer to the hardware
manual that came with your hardware:

» Setting Up Your GatorBox CS
» Setting Up Your GatorMIM CS
» Setting Up Your GatorBox CS/Rack

» Setting Up Your GatorBox

-

GatorBox User’'s Guide About this manual
August 1991 xi



Cayman Technical Services

If you need background and reference information, refer to the GatorBox
Reference.

For information on troubleshooting and diagnostics, refer to the GatorBox
troubleshooting guide, GatorAid.

If you need additional background information on Apple networking and
TCP/IP, refer to the following documentation:

» AppleTalk Network System Overview, Apple Computer, Addison
Wesley © 1989.

» Inside AppleTalk (2nd Edition), Sidhu, Andrews, and Oppenheimer,
Addison Wesley © 1990.

» Internetworking with TCP/IP Principles, Protocols, and Architecture (2nd
edition), Volumes I and II, Douglas Comer, Prentice Hall © 1991.

Cayman Technical Services

Cayman'’s Technical Services staff is experienced in the installation and
use of the GatorBox hardware and software. If this manual does not answer
your questions about the GatorBox, you can call Cayman’s Technical
Services staff at (617) 494-1999 on all regular business days from 9:00 AM
to 6:00 PM Eastern Time. You can also leave a message anytime by using
one of the following addresses:

FAX: (617) 494-5167
internet: support@cayman.com
AppleLink: CAYMAN.TECH

About this manual GatorBox User’s Guide
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What you need to know before you start

%« What you need to know before you start

-

L1

You should be familiar with basic Macintosh operations, such as clicking,
double-clicking, and dragging, and with the components of the Macintosh
user interface, such as menus, windows, dialog boxes, buttons, radio
buttons, and checkboxes.

If you are not familiar with Macintosh operations, review the documentation
that came with your Macintosh.

You should also be familiar with AppleTalk and Ethernet networks in
general and with your network topology in particular.

If you will be using the GatorBox for terminal emulation, print sharing, or
file sharing, you need to be familiar with the appropriate UNIX files,
commands, and protocols.

If you need more information about AppleTalk or Ethernet networks or the
concepts behind GatorShare, GatorSystem, or GatorPrint, refer to the
GatorBox Reference and to the documentation supplied with your network
hardware and software.

GatorBox User’'s Guide About this manual
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Where to start

Where to start

AR

|

About this manual

xiv

Start by setting up the GatorBox hardware.

Refer to your hardware installation guide for instructions on setting up
the hardware.

Next, install the software following the instructions in Chapter 2 of this
manual.

Then configure the GatorBox and make any application-specific
changes necessary.

‘The procedure for configuring your GatorBox depends on the functions
that you want the GatorBox to perform. You only need to configure
the GatorBox for the functions you want to perform. For example,
you do not need to set up TCP/IP options if you are only using
AppleTalk routing.

Application-specific changes vary depending on what functions you
want to perform. For example, you need to edit the config.tel file if you
are going to use NCSA Telnet.

In each configuration chapter there is a section entitled Minimum
configuration settings. That section provides the minimum steps
necessary for you to complete to configure the GatorBox to accomplish
certain tasks. For example, in Chapter 3 after completing the minimum
configuration steps, you could use TCP/IP to run NCSA Telnet.

Finally, when you have finished configuring your GatorBox, save the
changes and then restart the GatorBox. Refer to Restarting the GatorBox,
in Chapter 2 for instructions.

GatorBox User’s Guide
August 1991



Chapter 1
About the GatorBox

What is the GatorBox?
What is the GatorBox software?
What is GatorKeeper?

Sample network topology



What is the GatorBox?

(wy What is the GatorBox?

The GatorBox is an intelligent network gateway that connects a LocalTalk
network with an Ethernet network. The functions that the GatorBox can
perform depend on whether you are running GatorSystem, GatorPrint, or
GatorShare.

The GatorBox comes in four models and each of which has its own icon:

The original GatorBox is a desktop model that comes with 1 MB of
memory and requires an external power supply.

The GatorBox CS is a desktop model that comes with 2 MB of memory
and uses an internal power supply.

The GatorMIM CS is a media interface module that fits in a Cabletron
Multi-Media Access Center (MMAC™). The GatorMIM CS comes with
2 MB of memory.

The GatorBox CS/Rack is a rack-mountable version of the
GatorBox CS. The rack version is designed to fit in all standard 19 inch
racks. The GatorBox CS/Rack comes with 2 MB of memory.

What is the GatorBox software?

The software running in the GatorBox determines what services the
GatorBox can provide. GatorSystem is the basic software package that is
included with all the hardware platforms described above. GatorPrint and
GatorShare software can be purchased to add more functionality. The
features of each are described in the sections that follow.

Figure 1-1 illustrates the relationship between GatorSystem, GatorPrint, and
GatorShare,

GatorBox User’s Guide About the GatorBox
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What is the GatorBox software?

GatorSystem GatorPrint GatorShare
TCP/IP
services v v v
AppleTalk
routing v v v
DECnet routing v v v
UNIX-to-
LocalTalk printing v v
AppleShare-to-
NFS file sharing v

Figure 1-1. GatorBox software

What is GatorSystem?

With the GatorSystem software installed, the GatorBox can provide:

» AppleTalk routing — As an AppleTalk router, the GatorBox lets a
Macintosh on a LocalTalk network communicate with devices on an
EtherTalk or a remote LocalTalk network.

p TCP/IP gateway — As a TCP/IP gateway, the GatorBox lets
Macintoshes on LocalTalk networks access networks using TCP/IP
protocols. The Macintosh, (with the appropriate software installed) can
function as a terminal connected to a UNIX host, exchange electronic
mail with UNIX users, and transfer files to and from UNIX computers.

» DECnet routing — As a DECnet router, the GatorBox lets Macintoshes
on LocalTalk communicate with DECnet nodes on Ethernet.

About the GatorBox GatorBox User’s Guide

1-2

August 1991



-

What is GatorKeeper?

What is GatorPrint?

With the GatorPrint software, the GatorBox acts as a print gateway, letting
UNIX computers send print jobs to printers on AppleTalk networks.

What is GatorShare?

With the GatorShare software, the GatorBox acts as a file-sharing gateway,
letting Macintoshes on LocalTalk or EtherTalk view and use NFS (Network
File System) servers as though they were AppleShare file servers. Using an
NFS server as an AppleShare server provides greatly expanded disk storage
and file-sharing capability.

The GatorShare software also includes the GatorPrint software letting UNIX
computers send print jobs to printers on AppleTalk networks.

What is GatorKeeper?

GatorKeeper is the Macintosh application you use to configure GatorBoxes.
You run GatorKeeper to complete the configuration steps in the following
chapters. For instructions on starting up and using GatorKeeper, refer to
Starting up GatorKeeper and Getting around in GatorKeeper in Chapter 2,
“Getting Started.”

GatorKeeper also lets you administer and monitor GatorBoxes on your
LocalTalk network and in other AppleTalk zones on your internet. For
instructions on using GatorKeeper to monitor and administer your
GatorBox, refer to Chapter 8, “GatorBox Administration.”

Sample network topology

The sample network in Figure 1-2 gives you an idea of the types of devices
and connections that may exist in an environment where you use your
GatorBox. The sections that follow provide short examples of the functions
GatorBoxes provide in this sample network.

Information in dialog boxes throughout this manual is based on this sample
network. The examples in the Before you begin sections in each
configuration chapter are also taken from this sample network.

GatorBox User’s Guide About the GatorBox
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Sample network topology

.

Roulw«km/

GatorBox104321 /

# =

/ / ot Ethemnet

— Y/
= o=

Area 1 hawail paradise
Node 2 / 182.31.222.12 / 192.31.222.120
192.31.222.140 / Amnmno Ethemnet
GatorBaxtos678 GatorBox101234
Locallak 1250/ 192.31.241.1
Locallak 1470 / Support zono

5] = =F

Figure 1-2. Sample network diagram
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Sample network topology

% TCP/IP gateway

As a TCP/IP gateway, GatorBox 105678 lets Macintosh users on LocalTalk
networks 1470 log on to aruba through a Telnet connection. Using ftp, the
Macintosh users could then transfer files from their Macintosh to store on
aruba or vice versa.

AppleTalk routing

As AppleTalk routers, the GatorBoxes let Macintosh users on LocalTalk
network 1470 communicate with Macintosh devices on LocalTalk networks
1250 and 1540 and vice versa. For example, Macintosh users on 1470 could
print to the LaserWriter on 1250. The Macintoshes on the Ethernet could also
use services on the LocalTalk networks.

* You can also configure the GatorBox to use AppleTalk tunnels to
encapsulate AppleTalk packets inside of IP packets. For example, you could
set up a tunnel between GatorBox 105678 and 104321. This would allow
Macintosh users to communicate, but would keep the AppleTalk off the
backbone.

% DECnet routing

As a DECnet router, GatorBox 105678 lets Macintosh users on LocalTalk
1470 communicate with DECnet nodes on Ethernet using applications such
as Digital’s PATHWORKS.

Print gateway

As a print gateway, the GatorBox lets a user at UNIX workstations aruba,
hawaii, or paradise print files on the LaserWriter on LocalTalk network 1250.

AppleShare-to-NFsS file sharing

As a file sharing gateway, GatorBox 101234 lets Macintosh users on
LocalTalk 1250 use hawaii or paradise as an AppleShare file server, as long
as hawaii and paradise support NFS. From a Macintosh, you could mount a
volume on hawaii or paradise on your desktop, and use it as though it were
a volume on your own disk.

GatorBox User’s Guide About the GatorBox
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Chapter 2
Getting Started

Before you begin

What's on the disks

Copying the GatorBox software to your Macintosh
Copying NCSA Telnet to your Macintosh

Copying MacTCP Telnet to your Macintosh
Getting around in GatorKeeper

Starting up GatorKeeper |

Restarting the GatorBox
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Before you begin

Before you begin
Before you install GatorKeeper and the NCSA Telnet software, you should:

>
>
»
»
>
GatorBox User’s Guide

August 1991

Set up the GatorBox hardware and verify that it is connected to your
LocalTalk and Ethernet networks correctly.

Refer to Chapter 2 in your hardware manual for installation instructions.

If you are upgrading from GatorSystem to GatorPrint or GatorShare,
copy the software to your Macintosh and then run GatorInstaller.

Refer to Chapter 3 in your hardware manual for instructions on running
Gatorlnstaller.

If you are upgrading from GatorSystem to GatorPrint or GatorShare
on an original GatorBox, you have to download the software. Refer to
Chapter 3 in Setting Up Your GatorBox for downloading instructions.

Complete and return the user registration card included in your software
disk envelope.

Verify that you have the correct System and Finder on your Macintosh
start-up disk or hard disk. The GatorKeeper application requires
Macintosh System version 6.0.2 (or later) and Finder version 6.1 (or
laten).

Complete the Configuration Information Checklist in Appendix A.

Getting Started
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What's on the disks

What's on the disks
There are three disks in your GatorBox software package:

» The Configuration disk (Disk 1) for the GatorBox CS, GatorMIM CS,
and GatorBox CS/Rack contains:

>

GatorKeeper, which is the GatorBox configuration application that
runs on your Macintosh. You run GatorKeeper to configure and
monitor the GatorBoxes on your internet.

MacTCP folder, which contains MacTCP and the hosts file.
Gatorlnstaller, which is the utility that installs the software image

(GatorSystem CS, GatorPrint CS, or GatorShare CS) in the
GatorBox CS family of products.

original GatorBox.” The files are different from the files on the

@ If you are using an original GatorBox, your disks will be stamped “For

GatorBox CS disks, so if you are installing on both models, make sure
you use disks that correspond to the GatorBox model.

p The Configuration disk (Disk 1) for the GatorBox contains:

>

Getting Started
2-2

GatorKeeper, which is the GatorBox configuration application that
runs on your Macintosh. You run GatorKeeper to configure and
monitor the GatorBoxes on your internet.

GatorBox TFTP, which is the file you install on a Macintosh on
LocalTalk so the GatorBox can download even it GatorKeeper isn’t
running.

GatorBox UDP-TFTP, which is the file you install on a Macintosh
on EtherTalk so the GatorBox can download even if GatorKeeper
isn’t running.

MacTCP folder, which contains MacTCP and the hosts file.

GatorBox User’s Guide
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What's on the disks

<W » The Application disk (Disk 2) contains GatorSystem, GatorPrint, or
GatorShare, which is the software that runs in the GatorBox.

The application software for the GatorBox CS product family has a “CS”
at the end of the filename. For example, if you purchased GatorShare
to run on a GatorBox CS, the disk would be labelled GatorShare CS
Application.

» The Network Applications disk (Disk 3) contains:

>

-

GatorBox User’s Guide
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NCSA Telnet 2.4, which is the application that allows you to make
a Telnet connection from a Macintosh through the GatorBox to a
UNIX machine.

config.tel, which is the NCSA Telnet configuration file where you
specify host names, gateway address, IP addresses, and other NCSA
Telnet parameters.

bugs.2.4, which is a file that lists known bugs for NCSA Telnet
versions 2.0 through 2.4, .

Release notes.2.4, which is a file that lists changes in version 2.4
of the NCSA Telnet software.

UnStufflt 1.5, which is the application that allows you to
uncompact the Telnet documentation and the MacTCP version of
NCSA Telnet.

Docs.sit, which contains documentation and instructions for using
NCSA Telnet. They are in a compacted format. You must run
UnStufflt first before you can read them. The documentation is in
Microsoft Word™ 3.01 format.

MacTCP.version.sit which is the MacTCP version of NCSA Telnet.
It is in a compacted form, so you need to run UnStufflt first before
you can use it.

Getting Started
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Copying the GatorBox software to your Macintosh

Copying the GatorBox software to your Macintosh

1.

2.

Create a new folder for the GatorBox software,

Enter a name for the new folder. It might be helpful to name the folder
with the name of the software you're running, so you know what it
contains for example, GatorSystem.

Put the disk labeled Configuration (Disk 1) in the disk drive of your
Macintosh. '

Copy the files to the folder you created in Step 1.

You can run GatorKeeper from a Macintosh with dual floppy disk
drives, but a hard disk is recommended.

If you are using a GatorBox CS model, you can run Gatorlnstaller from
a floppy disk, but it will run faster on your hard drive. For that reason,
we suggest you copy it to your hard disk.

Remove the Configuration disk from your disk drive.

Put the disk labeled Application (Disk 2) into your disk drive.

Copy the file to the folder you created in Step 1.

Copying NCSA Telnet to your Macintosh

Getting Started
24

If you are going to use file sharing or terminal emulation functions, install
the NCSA Telnet software using the steps below.

l.

Create a folder for your NCSA Telnet files.

You can create the folder on your Macintosh hard disk or on your
application disk. Enter a name for the folder. It might be helpful to
name it Telnet, so you know what it contains.

Put the Network Applications disk (Disk 3) in the disk drive of your
Macintosh.

GatorBox User’s Guide
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Copying MacTCP Telnet to your Macintosh

3. Copy the NCSA Telnet 2.4 and the config.tel files to the folder you
created in step 1.

The config.tel and the NCSA Telnet 2.4 file must reside in the same
folder for the NCSA Telnet application to work.

You can also copy any other files you think you might want, for
example the bugs 2.3 or Docs.sit files. If you copy the Docs file you will
need to use UnStufflt to uncompact it, so you may want to copy that as
well (refer to Using UnStufflt, page 2-5).

Copying MacTCP Telnet to your Macintosh

if you have MacTCP installed on your Macintosh, you should use the
MacTCP version of the NCSA Telnet software.

Install the MacTCP Telnet software using the steps below.
1. Create a folder for your MacTCP Telnet files.

You can create the folder on your Macintosh hard disk or on your
application disk. Enter a name for the folder. It might be helpful to
name it Telnet, so you know what it contains.

2. Put the Configuration disk (Disk 1) in the disk drive of your
Macintosh.

3. Copy the MacTCP.version.sit, config.tel, and UnStuffit 1.5 files to the
folder you created in step 1.

The config.tel and the NCSA Telnet-MacTCP files must reside in the
same folder for the NCSA Telnet application to work. The MacTCP file
is in compacted form, so you need to run UnStuffl0, before you can use
it.

Using UnStuffit

Before you can use the MacTCP version of NCSA Telnet or read the Telnet
documentation, you need to run UnStufflt to uncompact the files.

GatorBox User’s Guide Getting Started
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Getting around in GatorKeeper

1.

2‘

Double-click the UnStuffit icon.
Select Open Archive from the File menu.
Click the name of the file you want to open, for example, Docs.sit.

A dialog box appears, listing the file and showing its size in both
compacted and uncompacted format.

Double-click the file name.

A dialog box appears asking where you want to put the file. Use the Drive
button to choose the drive location where you want the file to reside. Put
the file in the folder you created for the related application files.

Click Save when you have selected the location.

UnStufflt uncompacts the selected file and places it in the location you
selected. :

Getting around in GatorKeeper

You configure, administer, and monitor GatorBoxes using the GatorKeeper
application. GatorKeeper functions like other Macintosh applications, using
menus, windows, and icons. The GatorKeeper menu bar, GatorBoxes
window, and Configuration Options window are the components of
GatorKeeper that you will use most frequently. They are described in the
sections that follow.

Figure 2-1 shows a sample Macintosh desktop with GatorKeeper running and
the GatorBoxes window open.

Getting Started
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Getting around in GatorKeeper

" & File Edit Windows Special Uiew

5
Dogefla CatarDefiults CaseyPuppy
Kl =

Figure 2-1. GatorKeeper window, menu bar, and icons

GatorKeeper menu bar

The GatorKeeper menu bar at the top of the Macintosh screen displays the
titles of the GatorKeeper menus. Four menus ( ‘ (Apple), File, Edit, and
Windows) appear at all times when you are running GatorKeeper. The
Special and View menus appear only when the GatorBoxes window is
active.

If you are running GatorShare, the Server Access menu appears if the
GatorShare Server window is active.

The structure for the GatorKeeper menu bar is presented in Figure 2-2.

GatorBox User’s Guide Getting Started
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Getting around in GatorKeeper

GatorKeeper Maln Menu

Apple

Getting Started
2-8

File
I:‘c;"?&'m L New [ undo
Chooser

Edit Windows Spacial
GatorBoxes... [ Status...

L. Open . Cut Servers... L Diagnostics By lcon

TFIP Server _ info

- Close - Copy Info..,

| Save L Paste

. Save As... . Cloar

rﬁs'"n"fm“” | setoctan

- Page Setup

L. Statistics
= Cleanup View
-Rename GatorBox

~Change Password
[ Print = Restart GatorBoxes
= Quit L. Reload Software

Figure 22, GatorKeeper menu structure (GatorShare)

Many of the menu commands have a keyboard equivalent, allowing you to
use the Command key in combination with another key as a shortcut. For
example, holding down the Command key and pressing P is the same as
selecting Print from the File menu.

Some menu commands may be dimmed (displayed with gray letters instead
of black letters in the menu). When a command is dimmed, you cannot use

- it or its keyboard equivalent. Dimmed commands often indicate that you

need to supply more information for the command to be relevant. For
example, the Status command in the GatorKeeper Special menu remains
dimmed until you select a GatorBox icon.

GatorBoxes window

The GatorBoxes window, which is displayed when you select GatorBoxes
from the Windows menu, displays the icon of each GatorBox in the specified
AppleTalk zone. You use the icons in the GatorBoxes window to configure
or monitor your GatorBoxes. For example, you obtain diagnostics
information for a GatorBox by clicking its icon and choosing Diagnostics
from the Special menu.

GatorBox User’s Guide
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Getting around in GatorKeeper

Figure 2-3 shows the icons for three different models of the GatorBox in the
GatorBoxes window. CaseyPuppy is an original GatorBox, Dogzilla is a
GatorBox CS, and GatorMIM10007 is a GatorMIM CS.

E GatorBaones
I
) é
Dogeila GatorDefauts CaseyPuppy
GatorMiM100007
o
K| I}

Figure 2-3. GatorBoxes window

Looking in remote zones

When you open GatorKeeper, the GatorBoxes window presents you with
icons representing the GatorBoxes in your Macintosh’s current zone. You

can review configuration information about GatorBoxes in other LocalTalk
zones by pulling down the View menu and selecting Lookup in Zone

(Figure 2-4).

O View |

by Name
v by lcon

Lookup in Zone...

Figure 2-4. Lookup in remote zone

GatorBox User’s Guide Getting Started
August 1991 2-9



Getting around in GatorKeeper

GatorKeeper displays the Select Zone dialog box (Figure 2-5).

Select a Zone:

NCW

Phone Zone
Postal
QOANIia
Rapld Gate
Real Work

snozone
Support

Figure 2-5. Select Zone dialog box

Click the name of an AppleTalk zone in which one or more GatorBoxes
reside and click OK. GatorKeeper locates any GatorBoxes in that zone and
displays their icon or name in the GatorBoxes window (Figure 2-6). The
GatorBoxes window title indicates the name of the remote zone for which
GatorBox icons are displayed.

[ECJ== GatorBoxes in Zone 'Support' ==

fessnaaans® §
@ il
GatorDefaults
[ [
100441 109887
Ka] [

Figure 2-6. GatorBox icons from other zones
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Getting around in GatorKeeper

The lookup for GatorBoxes in a remote zone should take about 10-20
seconds. GatorKeeper adds icons to the window as additional GatorBoxes
respond to queries from GatorKeeper.

Viewing GatorBoxes by name

The View menu lets you display your GatorBoxes by icon or by name.
When you select View by Name, GatorKeeper presents an alphabetical list
of the GatorBoxes it finds in the designated zone, along with the status of
each GatorBox (Figure 2-7).

=[J=— GatorBoxes in Zone 'Support' ==0|
GatorBox Nzame Status

GatorDefaults Default Information

Ll

Kal
Figure 2-7. View By Name
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Getting around in GatorKeeper

Conflguratioh Options window

The Configuration Options window (Figure 2-8) allows you to enter and
modify the settings for your GatorBoxes. You access the Configuration
Options window by double-clicking the icon of a GatorBox displayed in the
GatorBoxes window. You can also access the Configuration Options
window by clicking a GatorBox icon and choosing the Open command
from the File menu. The Configuration Options window for a GatorBox
displays the GatorBox name as its title.

O TCP/IP 0
0 AppleTalk Routing
O DECnet Routing

O GatorPrint Printers
) SatorShare Servers

—

< o

Figure 2-8. Configuration Options window

Ifyou baven't purchased GatorPrint or GatorShare, you won't see GatorPrint
Printers or GatorShare Servers in your Configuration Options window.

Getting Started GatorBox User’s Guide
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Starting up GatorKeeper

Qw Starting up GatorKeeper

The first time you run GatorKeeper, you will be asked if you want to create
the GatorDefaults and GatorDatabase files. You must create these two files.
To start up GatorKeeper:

1.

2.

Double-click the GatorKeeper icon.

GatorKeeper displays a dialog box asking if you want to create the
GatorBox data files.

Click Create GatorBox Data Files.

Once these files have been created, you can configure your GatorBox.
Remember that you only need to configure the GatorBox for the options
you want to use.

>

Cw >

(e

To configure your GatorBox for TCP/IP, refer to Chapter 3, “TCP/IP
Services.”

To configure your GatorBox for AppleTalk Routing, refer to Chapter 4,
“AppleTalk Routing.” The GatorBox can be used as an AppleTalk router
as soon as it is connected to the network, using the factory default
settings.

For instructions on using your GatorBox as an AppleTalk router right
out of the box, refer to Running AppleTalk routing immediately in
Chapter 3 of your hardware manual.

To configure your GatorBox for DECnet routing, refer to Chapter 5,
“DECnet Routing.”

To configure your GatorBox for GatorPrint printing, refer to Chapter 6,
“GatorPrint Printing.”

To configure your GatorBox for AppleShare to NFS file sharing, refer to
Chapter 7, “GatorShare Servers.”
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Restarting the GatorBox

It is a good idea to save the changes you make as you configure your J
GatorBox. As you finish each chapter, save the changes you just made.

When you have finished configuring your GatorBox, you need to restart it

before the changes will take effect. Refer to the next section for instructions.

Restarting the GatorBox

Whenever you change the configuration settings in your GatorBox, you
must restart it in order for the settings to take effect. It's a good idea to save
your changes before you restart your GatorBox. To save changes and restart
your GatorBox:

1. Click the icon of the GatorBox you want to restart in the
GatorBoxes window.

2. Choose the Save command from the File menu.
3. Choose Restart GatorBoxes from the Special menu.

4. Click OK when the dialog box appears asking if you want to )
restart your GatorBox.

Restarting the GatorBox loads the updated configuration settings into the
GatorBox memory.

If you are using an original GatorBox, the Restart GatorBoxes command
downloads only the configuration settings and does not download the
operating system software. The Reload Software command downloads the
system software as well as the configuration settings and will take longer
to complete than the Restart GatorBoxes command.

Getting Started GatorBox User’s Guide
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About TCP/IP services

Sample TCP/IP configuration

Before you begin

Configuring your GatorBox for TCP/IP services

A TCP/IP services example — using NCSA Telnet



About TCP/IP services

(% About TCP/IP services

TCP/IP services let Macintosh users on LocalTalk establish a connection and
exchange data with TCP/IP-based computers through the GatorBox. By
enabling the GatorBox's MaclP functions, you can encapsulate TCP/IP
packets inside of AppleTalk packets to send to Macintoshes. Additionally,
you can use the GatorBox TCP/IP services to work with other
Macintosh-based applications such as X-Windows and electronic mail

‘gateways.

You must configure your GatorBox for TCP/IP services before you can use
UNIX-to-LocalTalk printing (described in Chapter 6) or AppleShare-to-NFS
file sharing (described in Chapter 7).

GatorShare uses TCP/IP services to allow you to share files with UNIX
machines. Other common applications that use TCP/IP services include:

Cayman Systems’ GatorMail
Stanford University’s SU-MacIP

HyperFTP

>

>

| 4

p NCSA Telnet
p Novell’'s Host Access

» Apple’s MacX

» InterCon’s TCP/Connect II

» Any Apple MacTCP-based application

If you are not familiar with the TCP/IP services, refer to the GatorBox
m Reference for a conceptual overview and background material.
GatorBox User's Guide TCP/IP Services
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Sample TCP/IP configuration

Sample TCP/IP configuration

‘The sample configuration in Figure 3-1 would allow Macintosh users on
LocalTalk networks 1250, 1470, and 1540 to open an NCSA Telnet
connection to aruba, hawaii, or paradise and transfer files to their Macintosh

using ftp.

e

Ilodw«km/

GatorBox104321 /

o B

/ sz Ethernet

/mam
Decnet UNIX UNIX
=) |

Area 1 hawali paradise
Node 2 19231.222.12 192.31.222.120
mmmuo Amuzz.ﬂo Ethernet
GatorBox105678 @ GatorBox101234 @
Locallak 1250 182.31.241.1
LocaiTak 1470 Support20n0

) &=

Figure 3-1. Sample TCP/IP network configuration
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Before you begin

Before you begin

Before configuring your GatorBox, you must gather information about your
TCP/IP network. If you filled out the information checklist form in Appendix
A, you will already have most of the information you need. You also need
to decide if you will be using IP subnetting or KIP style forwarding.

If you are not the Network Administrator, verify all of the addresses
that you plan to use with the administrator. You can cause network
problems if you use IP addresses that are already in use.

The addresses in parentheses come from the sample network shown on
page 3-2. Hawaii is the default gateway. The GatorBox105678 is being
configured for KIP forwarding.

p GatorBox IP address (192.31.222.140)

» Broadcast IP address (192.31.222.255)

Use the netstat -i command on your UNIX host to identify your Ethernet
interface. Then use the /ust/etc/ifconfig <interface> command to find
the broadcast address, network number, and subnet mask. Refer to your UNIX
system documentation for more information on using these or other UNIX
commands.

p Default gateway address (192.31.222.12)

» Subnet mask (255.255.255.0)

p KIP forwarding (not applicable if you are using IP subnetting)

> First IP address in range (192.31.222.141)
(This is usually the first address after the GatorBox’s address if it is
available.)

{> Number of static addresses

> Number of dynamic addresses

The range of IP addresses must be unique, they cannot be assigned to
any other hosts, and they must exist on the same network as the
GatorBox.
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Configuring ydur GatorBox for TCP/IP services

p IP subnet (not applicable if you are using KIP style forwarding) J

> LocalTalk IP address

> Subnet mask

(> First IP address in range
(This is usually the first address after the GatorBox’s address if it is
available.)

> Number of dynamic addresses,

Configuring your GatorBox for TCP/IP services

Instructions for configuring your GatorBox are provided in the sections that

follow. Make sure you have collected all the information outlined in the

section Before you begin. If you choose to, you can do a minimum

configuration, following the steps outlined in the Minimum configuration

settings section. This lets you configure the GatorBox for TCP/IP services

without going through every field in every dialog box. J

Minimum configuration settings

It is not necessary to go through every dialog box and fill in every field to
set up TCP/IP services. You can do a minimum configuration and still be
able to use TCP/IP services. Figure 3-2 shows the minimum steps you must
complete for KIP forwarding or IP subnetting. KIP forwarding is generally
simpler to configure than IP subnetting.

5
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Configuring your GatorBox for TCP/IP services

! Croose it 3
oose either:
Enter IP address and - KIP Reserve a range of
broadcast address |~ > M page 3-10 — | addresses
page 3-7 - Subnetting - KIP page 3-10
. - Subnettin
page 3-12 page 3-13°

4 5
Make application- Restart your
—> speciﬁc%anges —_— GatorBoy:
for example NCSA 2-14
Telnet, pgge 3-16 poge
C&W Figure 3-2. Minimum TCP/IP configuration settings

Entering TCP/IP parameters

Use the TCP/IP Parameters dialog box to specify basic information about
your TCP/IP network.

1. Turn on the GatorBox.
2. Double-click the GatorKeeper icon to start up GatorKeeper.

3. Double-click the icon or name of a GatorBox in the GatorBoxes

window.
GatorKeeper displays the Configurations Options dialog box (Figure
3-3).
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Configuring your GatorBox for TCP/IP services

EE===== Dogzille s

OTCP/IP

O AppleTalk Routing
OJ DECnet Routing

O GatorPrint Printers
O GatorShare Servers

0
« [

Figure 3-3. Configuration options window with TCP/IP selected

4. Double-click TCP/IP.
5. Click the TCP/IP Option On radio button.

When you turn TCP/IP on, additional TCP/IP information fields are
displayed (Figure 3-4).

Enter your TCP/IP parameters...

TCP/IP option LT W [192.51.222.140 |
|
®0n OOff  groadcast Address: [192.31.222.0 ]
[ Default Gateway address B4 Subnet mask
[192.31.222.12 | [255.255.255.0 |

[J Syslog host address

[ “MaclP” Options... |

[ Accept RIP packets
[JBroadcast RIP packets

Figure 3-4.TCP/IP Parameters dialog box

TCP/IP Services GatorBox User’s Guide
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% Enter IP 6. Enter the GatorBox’s IP address in the /P address field.
e

and

broadcast The IP address identifies the GatorBox to other devices on the network.
addresses It must be a unique address on your network.

You can verify that the address is not in use by issuing a ping [IP
address]) command from a UNIX host. If you receive an [IP address]
is alive response, the address is already in use.

If you are a Yellow Pages (NIS) user, verify that the IP address is not in
use by using the ypmatch command (ypmatch [IP address] hosts).

7. Enter the broadcast address in the Broadcast Address field.

The GatorBox uses its IP broadcast address to send broadcast messages
from LocalTalk-based or EtherTalk-based computers to all hosts on your
IP network.

If you are using an original GatorBox, the TCP/IP dialog box will have radio
button options to select the type of Ethernet cable you will be using. Thin
wire is the default. If you are going to be using transceiver cable, change
the setting.

You have completed the minimum configuration steps in this dialog box.
KIP gage Steps 8 Fhrough 16 are optio.nal. You can now go on to eittfer KIP style )
31 forwarding (KIP style forwarding, on page 3-10), or IP subnetting (MaclP with
5“"“3‘};‘}9 subnetting, on page 3-12). However, if you are using IP subnetting and your
page site uses RIP, we suggest that you go to Step 14 and turn on RIP (Routing
Information Protocol).

Go to:

8. Click the Default Gateway address checkbox.
The Default Gateway address field appears.

9. Enter the default gateway address in the Default Gateway address
field.

The default gateway is the machine to which the GatorBox sends
packets when it cannot otherwise resolve a network address.

GatorBox User’s Guide TCP/IP Services
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10. If you want the GatorBox diagnostics to be written to a UNIX
syslog file, click the Syslog host address checkbox.

Turning on the syslog host address option causes the GatorBox to write
the diagnostics log to the syslog file on the UNIX machine whose
address you enter.

For more information on the syslog file, refer to the UNIX man pages or
your UNIX system documentation.

The logging level of the messages written to the syslog file is
determined by what.you set in the GatorKeeper diagnostic messages
window. For instructions on changing the logging level of the
diagnostic messages, refer to Viewing GatorBox Diagnostics on page 8-6.

If you have the diagnostic log written to the UNIX syslog file, the
diagnostics will not appear in the GatorKeeper diagnostics message
window. Turning on the syslog option increases the amount of
network traffic the GatorBox handles and may adversely affect its
performance.

11. If you turned on the syslog file option, enter the address of the
UNIX host where the GatorBox will write the file.

The pop-up menu next to the address field indicates to the UNIX
machine where the message came from. User is the default and
indicates that the log was generated by a user process, in this case the
GatorBox.

12. Click the Subnet mask checkbox.

The subnet mask field appears with a subnet mask derived from the
GatorBox's IP address.

> Class A networks: 255.0.0.0
> Class B networks: 255.255.0.0
> Class C networks: 255.255.255.0

You can modify the subnet mask if you need to.

GatorBox User’s Guide
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13. Click the Accept RIP packets checkbox.

If RIP is used on your network, we suggest that you turn Accept RIP
packets on. Turning RIP on will help optimize the routing of packets.

If you specify that the GatorBox can accept RIP packets, the GatorBox
will periodically update its routing table. This IP routing information is
provided by other gateways on the GatorBox's Ethernet internet that
also support RIP.

If you specify that the GatorBox cannot accept RIP packets, the
GatorBox has no way of dynamically updating its routing table.
Consequently, all packets traveling through the GatorBox from the
LocalTalk network to a remote Ethernet network would be directed to
the default gateway specified for the GatorBox.

14. If you are going to use IP subnetting, click the Broadcast RIP packets
checkbox.

If you specify that the GatorBox can broadcast RIP packets, the
GatorBox will periodically broadcast that it is the gateway to the
LocalTalk network IP subnet. Broadcasting RIP packets is only useful if
you turn on IP subnetting in the MacIP options.

If you specify that the GatorBox can accept but not broadcast RIP
packets, you must specify a route to the subnetted LocalTalk in the
routing table of all IP routers and hosts on the Ethernet wire. You can
add routes to a routing table with the route add command on most
UNIX systems. Refer to Adding the GatorBox to the routing table, on
page 3-18, for instructions on using the route add command.

Follow the instructions in the next section for setting up MaclP using KIP
forwarding or IP subnetting.

Entering MaclIP parameters

The way in which you set up the MacIP parameters for your GatorBox
depends on whether the LocalTalk network behind the GatorBox is set up
as a separate IP subnet. Subnetting provides you with more addresses
without having to use up addresses on your backbone Ethemet. However,

GatorBox User’s Guide TCP/IP Services
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KIP forwarding is generally simpler to configure. You may want to start with
KIP when you first set up your GatorBox.

Directions for entering MaclP information with KIP style forwarding and for

entering MacIP information with IP subnetting turned on, are provided in
the sections that follow.

KIP style forwarding
To set up MacIP using KIP style forwarding (MacIP without subnetting):

1. Click the “MaclP Options” button from the TCP/IP Parameters
dialog box.

GatorKeeper displays the MacIP Options dialog box (Figure 3-5).

Please Enter TCP/IP MaciP Options...
MaclP support:

@ KIP Style forwarding
Q IP Subnet
Qofe

Please define a range of IP addresses reserved for Macintoshes
using MaclP...

First IP address in range: [192.31.222.141 |
Number of static addresses: |: I 192.31.222.141 -
192.31.222.143
Number of dynamic addresses: 192.31.222.144 -
. 192.31.222.148

Figure 3-5. MacIP Options dialog box
2. Click the KIP Style forwarding radio button.

3. Enter the first IP address of the range to be reserved in the First IP
address in range field.

This address must be an IP address not already in use on your IP
network.

GatorBox User’s Guide
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4. Enter the number of addresses to be reserved for static addresses
in the Number of static addresses field.

The addresses in the range that you reserve must not be in use
elsewhere on your network. This range generally is the number of
Macintoshes on your LocalTalk network that need to have a specific IP
address assigned to them.

GatorKeeper reserves the requested number of addresses, beginning
with the first address you specify. GatorKeeper displays the range of
reserved addresses to the right of the text entry field.

5. Enter the number of addresses to be reserved for dynamic
addresses in the Number of dynamic addresses field.

The addresses that you reserve in the dynamic range must not be in use
elsewhere on your network. Once the static addresses have been
assigned, GatorKeeper reserves the requested number of dynamic
addresses, beginning with the first address after the static address range.
GatorKeeper displays the range of reserved addresses to the right of the
text entry field.

Addresses in the dynamic range are assigned as needed to Macintoshes
requesting an IP address.

The total number of reserved addresses, static and dynamic, must be
less than 65.

6. Click OK.

Do not assign static IP addresses in your TCP/IP application that are
within the dynamic address range. The GatorBox reserves the
addresses in the dynamic range, and a manual assignment of an
address in that range can result in two devices trying to use the same
IP address and the failure of the TCP/IP services to work.

You have completed the minimum configuration steps for KIP style
forwarding. You can now go on to make application-specific changes. For
example, if you are using NCSA Telnet, refer to A TCP/IP services example —
using NCSA Telnet, on page 3-16. Once you have configured your GatorBox,
you must restart it before the configuration settings take effect. Refer to
Restarting the GatorBox on page 2-14.
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MaclP with subnetting

Turning the LocalTalk network behind the GatorBox into an IP subnet frees
up all the addresses on that subnet for LocalTalk devices. You won't see a
static address range field, because all the addresses are available for use.
Subnetting gives you more addresses without using up valuable addresses
on the backbone.

If you use NCSA Telnet from a Macintosh on the LocalTalk subnet, you
must specify the GatorBox as the gateway in your config.tel file. For
instructions, refer to the section Editing the config.tel file, on page 3-17.
If you are using MacTCP, specify the GatorBox as your gateway in the
Control Panel.

When you use subnetting, you must let your UNIX machines know that the
GatorBox is the gateway to the LocalTalk subnet. The simplest way to do
that, is to turn on Accept and Broadcast RIP packets in the TCP/IP
parameters dialog box.

If the UNIX machines you are connecting to do not use the RIP protocol, or
you do not want to turn RIP on in the GatorBox, use the route add
command to add the GatorBox to the UNIX machine’s route table. For more
information on the route add command, refer to Adding the GatorBox to the
routing table, on page 3-18.

To set up MaclIP with IP subnetting:

1. Click the “MaclP Options” button from the TCP/IP Parameters
dialog box.

GatorKeeper displays the MacIP Options dialog box.
1. Click the IP Subnet radio button.

- GatorKeeper displays the LocalTalk IP Address and Subnet Mask fields in
the MacIP Options dialog box (Figure 3-6).
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Please Enter TCP/IP MaclP Options...
MaclP support:

OKIP Style forwarding  Localalk IP Address:| 193.31.241.1 |

@ IP Subnet Subnet Mask: 255,255.255.0 |

Qofrr

Please define a range of IP addresses reserved for Macintoshes
using MaclP...

First IP address in range: [193.31.241.2 |

Number of dynamic addresses: ::g::gz: -fi-

Figure 3-6. MaclP Options dialog box — IP Subnet selected

2. Enter the GatorBox’s LocalTalk IP address in the LocalTalk IP
Address field.

3. Enter the subnet mask in the Subnet Mask field.

4. Enter the first IP address of the range to be reserved in the First IP
address in range field.

This address must be an IP address not already in use on your IP
network.

5. Enter the number of addresses to be reserved for dynamic
addresses in the Number of dynamic addresses field.

GatorKeeper displays the range of addresses to the right of the text

entry field.
6. Click OK.
End of You have completed the minimum configuration steps for MacIP with
minimum subnetting. You can now go on to make application specific changes. For
:;Jel:)nsettmg example, if you are using NCSA Telnet, refer to A TCP/IP services example —

using NCSA Telnet, on page 3-16. When you have configured your
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GatorBox, you have to restart it before the changes can take effect. Refer to
Restarting the GatorBox on page 2-14.

Entering low-level parameters

Whether or not you need the low-level parameters depends on the
applications you are using and the environment in which you are
operating.

Situations where you may need to enter low-level parameters include:

>

If you use applications that do not provide for name server
configuration, such as Brown University's tn3270. The GatorBox can
supply a default name server address for applications that need to
resolve a name into an IP address.

If you use applications designed for older versions of the Kinetics
FastPath, use DDP style ARP. DDP ARP is very rarely used, so be sure
you really need it before you choose this option.

If you use multiple GatorBoxes or other routers configured for MacIP
that have the same LocalTalk zone names, use Restrict MaclP service to
LocalTalk.

To enter low-level MaclP options:

1.

2.

Click the MaclP Options button in the TCP/IP dialog box.
GatorKeeper displays the MacIP Options dialog box.

Click the More button at the bottom of the MacIP Options dialog
box.

GatorKeeper displays the Additional TCP/IP MacIP Parameters dialog
box (Figure 3-7).
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Rdditional TCP/IP MaclP Parameters:

Name Server Address: ﬂo.o.n.u |
File Server Address: 0.0.0.0
User-Defined Addresses:|0.0.0.0

0.0.0.0

0.0.0.0

0.0.0.0

it

Select the style of AppleTalk ARP used: @ NBP (KIP) Style ARP
O DDP Style ARP

[ Restrict MaclP service to LocalTaelk

Figure 3-7. Additional TCP/IP MaclP Parameters dialog box

3. Enter the IP address of your name server in the Name Server
Address field.

The File Server Address field and the four Other Addresses fields are not
used by the GatorBox software. You can enter information in these fields if it
is required by other applications.

4. Select the AARP style by clicking on the appropriate radio button.

AppleTalk Address Resolution Protocols (AARPs) enable Macintoshes
running MaclIP to associate an IP address with an AppleTalk address.
Choose either:

> NBP (KIP) Style ARP if you want the GatorBox to offer MaclIP support
to all LocalTalk and EtherTalk networks within a given AppleTalk
zone. The NBP (KIP) Style ARP radio button is the default.

> DDP Style ARP if you use network applications designed to work
with older versions of the FastPath

GatorBox User’s Guide TCP/IP Services
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5. Click the Restrict MaclP service to LocalTalk checkbox.

Restricting NBP Lookups allows multiple AppleTalk IP routers to
provide MaclP services to LocalTalk networks with the same zone
name.

6. Click OK.

A TCP/IP services example — using NCSA Telnet

[0

TCP/IP Services
3-16

Once you have configured your GatorBox for TCP/IP, you can use TCP/IP
applications such as NCSA Telnet. The sections that follow provide steps to
complete for typical uses of TCP/IP services with NCSA Telnet as an
example. These steps are designed to be used by Macintoshes that are
connected to the same LocalTalk network as the GatorBox.

The Network Applications disk (Disk 3) that contains the NCSA Telnet and
MacTCP software also contains Telnet documentation if you need to refer
to it.

Setting up your host for NCSA Telnet
connections

Before you can begin using NCSA Telnet, you must:

p Edit the config.tel file on the Macintosh. The config.tel file lets the
Macintosh know the names and IP addresses of hosts to which you will
be opening Telnet connections.

» Let the UNIX machine know that the GatorBox is the gateway to the
LocalTalk subnet, if you are using IP subnetting. You can do that in one
of the following ways:

> Configuring the GatorBox to broadcast RIP packets (refer to page
3-9).

> Manually adding the GatorBox to the host’s route table using the
route add command.

GatorBox User’s Guide
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Editing the config.tel file

The config.tel file lets the Macintosh running NCSA Telnet know the names
and IP addresses of hosts to which you will be opening Telnet connections.

You should have the config.tel file in the same folder as the Telnet software.
If you haven't copied it to the folder yet, follow the installation instructions
in Chapter 2, then complete the steps that follow to edit the file.

You can edit config.tel using a text editor or word processor that can save
files in text-only format (Teach Text, Microsoft Word, MacWrite). Lines that
begin with a pound sign (#) are comment lines only and are not executable.
To uncomment a line, remove the pound sign.

1.

2.

-

Add aAppleTalk to the *hardware=~ field.

Add the name of the LocalTalk zone in which your GatorBox
resides in the “zone=" field.

You only need a zone name if you have routing turned on and you have
defined a zone name.

Add your host names, IP addresses, and gateway name to the end
of the file, for example:

name=hawaii; hostip=192.31.222.12;

If you are using IP subnetting, you must add the GatorBox as the
gateway entry.

The entry must include the GatorBox name, LocalTalk subnet address
and gateway name, for example:

name=GatorBox101234; hostip=192.31.241.1; gateway=sl

The gateway=1 entry is the first gateway the GatorBox will try if it
cannot resolve a network address. It is the same as the default gateway,
and if you entered it here and not in the Default Gateway address field
in the TCP/IP dialog box, the GatorBox will still find it.

GatorBox User’s Guide TCP/IP Services
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5, Save the config.tel file and exit the text editor.

The config.tel file should now show up as a document from your text
editor.

Adding the GatorBox to the routing table

If you are using subnetting and you cannot turn on Broadcast RIP Packets in
the TCP/IP parameters dialog box, or if the host you are connecting to does
not use the RIP protocol, you need to manually add the GatorBox’s subnet
to the host’s routing table.

The host’s routing table must be updated so the host can pass information
back through the GatorBox to the Macintoshes on the subnet behind the
GatorBox. The routing table includes the GatorBox's LocalTalk subnet and
IP addresses. It also includes the number of other gateways it may have to
go through to get to the GatorBox's subnet. This is called the hop count.

Complete the following steps to add a GatorBox to the host routing table.
(These steps work on most UNIX systems. If you have problems, check with
your network administrator or refer to your host system documentation.)

1. Log in at your UNIX host machine.

2. To see the routing table, type:

netstat -r

3. Add the GatorBox to the host’s routing table by typing:

route add (LocalTalk subnet address] [GatorBox IP address]
[hop count] :

The command to add GatorBox101234 from our example would look
like:

route add 192.31.241.0 192.31.222.110 1

4. Type netstat -r again to make sure the route has been added.

TCP/IP Services GatorBox User's Guide
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Using NCSA Telnet with dynamic addressing

Before you begin:

>

>

>

Copy the NCSA Telnet files to your hard disk. (For instructions on
copying the software, refer to Copying NCSA Telnet to your Macintosh
on page 2-4).

Configure the GatorBox for TCP/IP services:

(> Enter the GatorBox's IP and broadcast address (page 3-5).

> Turn on KIP style forwarding in the MaclP options (page 3-10).
[> Reserve a range of dynamic addresses (page 3-10).

Edit the config.tel file (for instructions on editing the config.tel file refer
to Editing the config.tel file, on page 3-17).

Make sure the GatorBox has a status of Running, refer to Viewing the
GatorBox Status on page 8-1.

To use NCSA Telnet:

1.

2.

3.

Double-click the NCSA Telnet 2.4 icon.
Choose Assign Dynamically in the dialog box that appears.

Enter (in hexadecimal) the same subnet mask you used in your
GatorBox.

> Class A networks: 255.0.0.0 = ff000000
> Class B networks: 255.255.0.0 = ffff0000
> Class C networks: 255.255.255.0 = ffffff00

Enter the IP address of the host to which you will connect most
frequently in the Default Host field.

Click OK.
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7.

9.

The NCSA application pauses while it acquires its dynamic IP address
from the GatorBox.

Choose Open Connection from the File Menu.

You should see the IP address of the default host in the Session Name
field. If you want to log on to a host other than the default, type its IP
address in the Session Name field.

Click OK.

A window opens with a prompt for your logon.

Enter your UNIX logon and press Return.

Enter your password and press Return.

The UNIX prompt now appears.

To end a NCSA Telnet session:

Type logout at the UNIX prompt.

Using NCSA Telnet and MacTCP with static
addressing

Before you begin:

>

Copy the MacTCP files to your System Folder. (For instructions on
copying the software refer to Copying MacTCP Telnet to your Macintosh
on page 2-5.)

Configure the GatorBox for TCP/IP services:

[> Enter the GatorBox’s IP and broadcast address (page 3-5).

> Turn on KIP style forwarding in the MaclP options (page 3-10).

> Reserve a range of static addresses (page 3-10).
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Edit the config.tel file (if you want to be able to use host names rather
than entering IP addresses, add the host names, using step 3. in the
Editing the config.tel file section.) This is an optional step.

Make sure the GatorBox has a status of Running, refer to Viewing the
GatorBox Status on page 8-1.

To use NCSA Telnet with MacTCP, first set up MacTCP and then make your
Telnet connection.

Setting up MacTCP

To set up MacTCP:

1‘

2.

3.

Select the Control Panel from the Apple menu.
Select MacTCP from the Control Panel.
Choose LocalTalk.

If AppleTalk Routing is turned on, a zone list appears. Select the zone
where the GatorBox is located.

Click the More button.

Click the Manually radio button.

Select the correct class of your network.

Enter your gateway address in the Gateway address field.

This only applies if you are going to be making a NCSA Telnet
connection to a device that is not the same Ethernet as the GatorBox.

Click OK.
Enter the IP address of your Macintosh.

The IP address must be within the static range you defined in the MacIP
Options dialog box (refer to page 3-10).
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10. Close the Control Panel.

11. Reboot your Macintosh.

Making your NCSA Telnet connection

1.

2.

4.

5.

Double-click the NCSA Telnet 2.4-MacTCP icon.

Pull down the File menu and select Open Connection.

You should see the IP address of the default host in the Session Name
field, if you defined a default host in the Configure Network dialog box.
If you want to log on to a host other than the default, type its IP address
in the Session Name field.

Click OK.

A window opens with a prompt for your logon.

Enter your UNIX logon and press Return.

Enter your password and press Return.

The UNIX prompt now appears.

To end a NCSA Telnet session:

Type logout at the UNIX prompt.

Using NCSA Telnet with IP subnetting

Before you begin:

>

Copy the NCSA Telnet 2.4 files to your hard disk. (For instructions on
copying the software refer to Copying NCSA Telnet to your Macintosh on
page 2-4).

Configure the GatorBox for TCP/IP services:

> Enter the GatorBox's IP address and subnet mask (page 3-5).
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> Turn on IP subnetting in the MacIP options (page 3-12).
> Reserve a range of dynamic addresses (page 3-12).

Edit the config.tel file. For instructions on editing the config.tel file, refer
to Editing the config.tel file, on page 3-17.

Turn on accept and broadcast RIP packets (page 3-9) or manually add
the GatorBox to the host routing table (page 3-18).

Make sure the GatorBox has a status of Running, refer to Viewing the
GatorBox Status on page 8-1.

To use NCSA Telnet with IP subnetting:

1.

2.

Double-click the NCSA Telnet 2.4 icon.
Choose Assign Dynamically in the dialog box that appears.

Enter (in hexadecimal) the same subnet mask you used in your
GatorBox.

> Class A networks: 255.0.0.0 = ff000000
> Class B networks: 255.255.0.0 = ffff0000
> Class C networks: 255.255.255.0 = fHffff00

Enter the address of the host you will most frequently connect to
in the Default Host field.

Click OK.

The NCSA application pauses while it acquires its dynamic IP address
from the GatorBox.

Choose Open Connection from the File Menu.
You should see the IP address of the default host in the Session Name

field. If you want to log on to a host other than the default, type its IP
address in the Session Name field.
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7. Click OK.
A window opens with a prompt for your logon.
8. Enter your UNIX logon and press Return.
9. Enter your password and press Return.
The UNIX prompt now appears. .
To end a NCSA Telnet session:

Type logout at the UNIX prompt.
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Chapter 4
AppleTalk Routing

AppleTalk routing guidelines

Sample AppleTalk routing configuration
Default settings for AppleTalk routing
Before you begin

Configuring your GatorBox for AppleTalk routing



AppleTalk routing guidelines

connected to your network. If you choose to use the defaults, you do
not need to make any changes to the configuration settings. To see
what the default settings are, refer to Default settings for AppleTalk
routing on page 4-4.

(%/ ! Your GatorBox is configured to be an AppleTalk router as soon as it is

If you are using an original GatorBox, you have to download the system
software before you can begin routing. Refer to Chapter 3 in Setting Up
Your GatorBox for downloading instructions.

AppleTalk routing guidelines

A router is a device connecting two or more physical networks. A router
scans packets to determine which network they are intended for and
forwards (routes) them from one network to the other when appropriate.
Routers let you expand your internet beyond the size of a single network
and improve network performance by isolating local traffic on ea
connected network. '

(W LocaiTalk and Ethernet network numbers and zone names should be
assigned according to the logic of your network topology. For example, you
may assign numbers according to your floor plan and names according to
functional organizations within your company, such as Sales, Marketing or
Engineering.

For an explanation of AppleTalk routing, refer to Chapter 4 in the GatorBox
m Reference.

Because a router connects two or more physical networks, networks on
both sides of the router must agree on names and addresses they will be
using. Use the following guidelines to avoid errors and problems on your
network. Guidelines differ depending on whether you are setting up Phase
1, Phase 2, or both.

-
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Phase 1 guidelines

>
>

>

Each LocalTalk network must have a unique network number.
Each EtherTalk network must have a unique network number.

Although AppleTalk networks may share zones names, we suggest that
you make zone names unique for each network.

GatorBoxes and other routers on a LocalTalk or EtherTalk network must
agree on the name and number of that network.

Phase 2 guidelines

>
>

>

Each LocalTalk network must have a unique network number.

The range of numbers assigned to each EtherTalk network must be
unique and they cannot overlap with any other AppleTalk network
numbers or range of numbers.

GatorBoxes and other routers on the same network must agree on the
range of network numbers and the list of zone names.

Mixed Phase 1 and Phase 2 guidelines

>

>

AppleTalk Routing
4-2

The Phase 2 EtherTalk must have a range of one, (for example 3 to 3)
and have only one zone name assigned to it.

Each LocalTalk and EtherTalk network must have a unique network
number.

Although AppleTalk networks may share names, we suggest that you
make zone names unique for each network.

GatorBoxes and other routers on the same network must agree on the
name and number of that network.

GatorBox User’s Guide
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Sample AppleTalk routing configuration

Sample AppleTalk routing configuration

Using the sample network below, if we were to configure GatorBox105678
for AppleTalk routing, Macintosh devices on LocalTalk 1470 could
communicate with Macintosh devices on LocalTalk network 1250 and with
Macintoshes on the Ethernet.

The information in parentheses in the section Before you begin comes from
this example, as does the information you will see in the dialog boxes
throughout this chapter.

Locallak 1540

Real Wotk zone

cee .ee

GatorBox104321 /

(/A

ba
A Wus _ Ethemet
192.55.44.1
Decnet UNIX UNIX
5 OE B
'5" Y
Area 1 hawail paradise
Node 2 / 192.31.222.12 / 192.31.222.120
19&31222140/ Asui.zzz.ﬂo Ethernet
GatorBox105678 @ GatorBox101234 @
Locallak 1250 192.31.241.1
Locallaik 1470 / Support 2000
/ Hyphenation zone ,..__,/ / Moving Fingor

=] o =F

Figure 4-1. Sample network diagram
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Default settings for AppleTalk routing

The GatorBox is configured to be an AppleTalk router as soon as it is
connected to your network. You can use the default settings and skip the
rest of the chapter. The default settings are listed in Figure 4-2.

Setting Default value
LocalTalk Phase 2 On
Routing type Soft seed port
Network number Number based on GatorBox
serial number
LocalTalk zone name LocalTalk<serial number>
EtherTalk Phase 2 On
Routing type Soft seed port
Network number range 2 to 2 (unextended Phase 2 EtherTalk)
Zone name Phase 2 Zone

Figure 4-2. Default AppleTalk routing settings

Figure 4-3 shows the AppleTalk routing configuration dialog box with the
AppleTalk routing defaults for the GatorBox105678.

AppleTalk Routing GatdrBox User’s Guide
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Before you begin

Enter your AppleTalk Router parameters: ( Filtering. )
fAippleTalk Routing: ® On O Off (—KiF Optionse )
(AppleTaik Tunnels...)

LocalTalk Network: Soft Seed Port

Number: [15678 | Zone Name: [LocalTalk105678 |

[JPhase 1 EtherTelk:

X Phase 2 EtherTalk:
Network range: |2 | ve: {2 ] (2onetist.)

Figure 4-3. AppleTalk routing configuration dialog box with default settings

'Before you begin

If you choose not to use the default settings, you need to gather the
information listed below to configure your GatorBox for AppleTalk routing.
You also need to decide if you are going to use EtherTalk Phase 1 or Phase
2 or both.

The information in parentheses in this section comes from the sample
network shown in Figure 4-1 on page 4-3. GatorBox105678 is being
configured for Phase 2. In addition we are setting up an AppleTalk tunnel
from GatorBox105678 to GatorBox104321.

p LocalTalk network number (1470)

p LocalTalk zone name (Hyphenation)

» Choose the routing type:

> Seed Port, Non Seed Port,
or Soft Seed Port

GatorBox User’s Guide AppleTalk Routing
August 1991
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Before you begin

Choose either EtherTalk Phase 1, Phase 2, or Phase 1 and 2:

» Phase 1 EtherTalk

>
>

Network number

Zone name

» Phase 2 EtherTalk

g

>

Network number range

Choose the routing type:

Seed Port, Non Seed Port,
or Soft Seed Port

Zone list

p Phase 1 and 2 EtherTalk

>

>

v Vv

AppleTalk Routing
46

Network number

Choose the routing type:

Seed Port, Non Seed Port,
or Soft Seed Port

Zone name

Network number range
(must be a range of 1)

Zone list

(22200) to (22299
_______ (caribbean)
- (EtherTalk)
to
GatorBox User's Guide
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%f Configuring your GatorBox for AppleTalk routing

If you choose not to use the default settings, follow the instructions for
configuring your GatorBox provided in the sections that follow. Make sure
you have collected all the information outlined in the section Before you
begin. If you choose to, you can do a minimum configuration, following the
steps outlined in the Minimum configuration settings section. This allows
you to set the GatorBox up as an AppleTalk router without going through
every field in every dialog box.

Refer to Chapter 4 in the GatorBox Reference for a better understanding of
AppleTalk routing.

Minimum configuration settings

It is not necessary to go through every dialog box and fill in every field to
set up AppleTalk routing. Figure 4-4 shows the minimum steps you must
complete to start AppleTalk routing if you don’t want to use the defaults.

2 3
Enter LocalTalk Enter EtherTalk Restart your
number and name number and name GatorBox
—> —>
page 4-9 Phase 1, page 4-10 page 2-14

Phase 2, page 4-12
Phase 1 & 2, page
4-16

Figure 4-4. Minimum AppleTalk routing configuration settings

-
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Configuring your GatorBox for AppleTalk routing

Configuring LocalTalk

The first step in setting up your GatorBox for AppleTalk routing is to
configure the LocalTalk port. Complete the steps that follow to configure
your GatorBox for LocalTalk:

1. Double-click the GatorKeeper icon to start up GatorKeeper.

2. Double-click the name or icon of your GatorBox in the
GatorBoxes window.

GatorKeeper displays the Configuration Options dialog box (Figure

4-5).

O AppleTalk Bouting
O DECnet Routing

O GatorPrint Printers
O GatorShare Servers

=]

o2

Figure 4-5. Configuration options window with AppleTalk Routing selected

3. Double-click AppleTalk Routing.

GatorKeeper displays the AppleTalk routing dialog box (Figure 4-7).

4. Click the AppleTalk Routing On radio button.

GatorKeeper displays the Apple'i'alk routing fields.

AppleTalk Routing
48
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number &

name

Configuring your GatorBox for AppleTalk routing

Enter your AppleTalk Router parameters: C
AppleTalk Routing: @ On- O Off (

Filtering... )
KIP Options... )

AppleTalk Tunnels...
LocalTalk Network: Soft Seed Port

Number: Zone Neme: ngphanatlon |

X Phase 1 EtherTaik:  [Soft Seed Port ]
Number: |2 | 20ne Neme: | EtherTalk |

O Phase 2 EtherTalk:

Figure 4-6. LocalTalk network routing information

5. Enter the LocalTalk network number in the LocalTalk Network
Number field.

This is the number of the LocalTalk network connected to the
GatorBox. Values can be any number from 1 to 65366.

6. Enter the zone name in the LocalTalk Network Zone Name field.

This is the zone name of the LocalTalk network connected to the
GatorBox. Since an AppleTalk zone can be shared by two or more
AppleTalk networks, you can assign the same zone name to more than
one network if you want the services on those networks grouped
together in the Chooser.

Zone names can have up to 32 characters. If you enter a zone name that
does not exist, you create a new zone.

If you rename the LocalTalk zone behind the GatorBox you must turn
off the GatorBox for 2-3 minutes (15 minutes if you are using
EtherTalk Phase 1) and then restart it. Failure to do so may cause other
AppleTalk devices to ignore the LocalTalk network with the new zone
name.

GatorBox User’s Guide AppleTalk Routing
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Configuring your GatorBox for AppleTalk routing

Phase 1
EtherTalk:

number &
name

7. Choose the LocalTalk routing type:

> Soft seed is the default. Soft seed means that you configure the
GatorBox with network information. When the GatorBox comes
up, it tries to get network information from another router. If the
GatorBox doesn’t find any other routers, it uses the network
information as you configured it.

> Seed means that the GatorBox uses the network information as you
configured it.

> Non Seed means you don't configure the GatorBox with network
information. When the GatorBox comes up, it discovers the
network information from another router on the network.

The next steps you use depend on whether you are going to configure your
GatorBox for EtherTalk Phase 1, Phase 2, or Phase 1 and 2. Complete the
steps for the EtherTalk Phase you have chosen.

If you are unsure which Phase to use, refer to Chapter 4 in the GatorBox
Reference for an explanation of Phase 1 and Phase 2.

Configuring EtherTalk Phase 1

If you want your GatorBox to support just EtherTalk Phase 1:

1. Click off the Phase 2 EtherTalk checkbox.

2. Click the Phase 1 EtherTalk checkbox.

3. Enter the network number in the Phase 1 EtherTalk Number field.
This is the number assigned to the EtherTalk network connected to the
GatorBox. The network number that you enter in this field must be used
by all routers on your EtherTalk to identify your EtherTalk network.

Your EtherTalk network number must be different than the network
number of any AppleTalk network.

AppleTalk Routing GatorBox User’s Guide
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Configuring your GatorBox for AppleTalk routing

Enter your AppleTalk Router parameters: ( Filterin Ty )
AppleTalk Routing: @ On O Off (—KiF options )

(AppleTaik Tunnels...)

LocalTalk Network: [Soft Seed Port |

Number: Zone Name: [Hyphenation |
[ Phase 1 EtherTalk: |Soft Seed Port

Number: D 2one Name: | EtherTalk |

[JPhase 2 EtherTalk:

Figure 4-7. AppleTalk routing — Phase 1 EtherTalk

4.

Enter the zone name in the EtherTalk Zone Name field.

This is the zone name assigned to the EtherTalk network connected to
the GatorBox. The zone name that you enter in this field must be used
by all routers on your EtherTalk to identify your Phase 1 EtherTalk
network.

Zone names can have up to 32 characters.
Choose the EtherTalk routing type:

> Soft seed is the default. Soft seed means that you configure the
GatorBox with network information. When the GatorBox comes
up, it tries to get network information from another router. If the
GatorBox doesn't find any other routers, it uses the network
information as you configured it.

> Seed means that the GatorBox uses the network information as you
configured it.

> Non Seed means you don't configure the GatorBox with network
information. When the GatorBox comes up, it discovers the
network information from another router on the network.

GatorBox User’s Guide AppleTatk Routing

August 1991
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Configuring your GatorBox for AppleTalk routing

6.

Click OK.

You have completed the minimum configuration steps for AppleTalk
routing. If you have finished configuring your GatorBox, restart it so the
changes will take effect. Refer to Restarting the GatorBox on page 2-14.

Configuring EtherTalk Phase 2

If you want your GatorBox to support just EtherTalk Phase 2:

Click the Phase 2 EtherTalk checkbox.

The routing type popup menu, Network range fields and the Zone List
button appear in the dialog box (Figure 4-8).

Enter your AppleTalk Router paremeters: (_Tiitering... )
AppleTalk Routing: ® On O Off (C_Kip Options... )

(AppieTalk Tunnels...)

LocalTalk Network:  [Soft Seed Port_)
Number: Zone Name: [Hyphenation |

[OPhase 1 EtherTalk:

BJ Phase 2 EtherTalk:
Network range: 32200 | v0:[22299 |  (Zone List.)

Figure 4-8. AppleTalk Configuration dialog box — Phase 2 EtherTatk

2. Choose the EtherTalk routing type:

Phase 2 1.
EtherTalk:
number &
name

AppleTalk Routing

412

> Soft seed is the default. Soft seed means that you configure the
GatorBox with network information. When the GatorBox comes
up, it tries to get network information from another router. If the
GatorBox doesn't find any other routers, it uses the network
information as you configured it.

GatorBox User’s Guide
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Configuring your GatorBox for AppleTalk routing

> Seed means that the GatorBox uses the network information as you
configured it.

> Non Seed means you don't configure the GatorBox with network
information. When the GatorBox comes up, it discovers the
network information from another router on the network.

3. Enter the starting and ending numbers for the network range in
the Network range fields.

This range must agree with the range used by other routers on the Phase
2 EtherTalk network. The network numbers of your Phase 2 EtherTalk
networks must be different than the number of your LocalTalk
networks.

Since each AppleTalk Phase 2 network number can support a maximum
of 254 nodes, you must enter a range broad enough to support all the
Macintoshes you plan to place on EtherTalk. For example, if you have
2000 Macintoshes on EtherTalk and plan to add several hundred more,
you could specify a range of 61 to 70, which would support 2540

; A Macintoshes.

4. Click the Zone List button to access the Zone List dialog box
(Figure 4-9).

You must define at least one zone name. The zone names you add must
agree with those defined in other routers on your EtherTalk network.

GatorBox User’s Guide AppleTalk Routing
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Phase 2 EtherTslk 2one list:

(Chenge)  (Welete )
Caribbean

Default 2one:
Ethertalk

Figure 4-9. Zone List dialog box

5. Specify the name of each AppleTalk zone you want to add to your
zone list and click the Add button.

The first name you add will be the default zone unless you set another
default. You can add as many as 32 zone names to the Phase 2
EtherTalk zone list.

> If you mistype a zone name, click the misspelled zone name, make
corrections in the text box, and click the Change button.

> To remove a zone name from the list, select the zone name and
click the Delete button.

> If you click the Cancel button, GatorKeeper deletes any changes
you have made and closes the Zone List dialog box.

6. To set or change the default zone setting, select a zone name and
click the Set Default button.

All EtherTalk routers must agree on the default zone and the names on the
2Zone list.

AppleTalk Routing GatorBox User's Guide
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Configuring your GatorBox for AppleTaik routing

w 7. Click OK when you have finished entering zone names.
You will be returned to the AppleTalk Configuration dialog box.

8. Click OK.

You have completed the minimum configuration steps for AppleTalk

End of min- ] ) i .

imum routing. If you have finished configuring your GatorBox, restart it so the
r::éf‘ gz changes will take effect. Refer to Restarting the GatorBox on page 2-14.
steps

Configuring EtherTalk Phase 1 and Phase 2

If you want your GatorBox to support both EtherTalk Phase 1 and Phase 2:

1. Click the Phase 1 EtherTalk checkbox.

Phase1&2| 2. Choose the EtherTalk routing type:
EtherTalk:

:,“;ﬁgf r& > Soft seed is the default. Soft seed means that you configure the

GatorBox with network information. When the GatorBox comes
w up, it tries to get network information from another router. If the

GatorBox doesn't find any other routers, it uses the network
information as you configured it.

> Seed means that the GatorBox uses the network information as you
configured it.

> Non Seed means you don’t configure the GatorBox with network
information. When the GatorBox comes up, it discovers the
network information from another router on the network.

3. Enter the network number in the Phase 1 EtherTalk Number field.

This is the number assigned to the EtherTalk network connected to the
GatorBox.

4. Enter the zone name in the Phase 1 EtherTalk Zone Name field.

This is the name assigned to the Phase 1 EtherTalk network connected
to the GatorBox. Zone names can have up to 32 characters.

-
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5.

Click the Phase 2 EtherTalk checkbox.

The routing type popup menu, Network Range fields and the Zone List
button will appear in the dialog box (Figure 4-10).

Enter your AppleTalk Router parameters: (

Filtering... }
fppleTalk Routing: @ Gn O Off

(AppleTalk Tunnsls...]

LocalTalk Network: Soft Seed Port

Number: 2one Name: [Huphenatlon ]

B3 Phase 1 EtherTalk: |Soft Seed Port I
Number: E Zone Name: | EtherTalk |

(X Phase 2 EtherTalk: [Soft Seed Port

Network range: Iz I'l’o: |2 | (zone List...)

Figure 4-10. AppleTalk Configuration dialog box — EtherTalk Phase 1 and Phase 2

6.

7.

AppleTalk Routing
4-16

Enter the starting and ending numbers for the network range in
the Network range fields.

If Phase 1 and Phase 2 AppleTalk are both turned on, the Phase 2
network will be “advertised” to the Phase 1 network only if the start and
end of the Phase 2 range are the same (for example, from 2 to 2).
Consequently, if you want to run both Phase 1 and Phase 2, enter the
same number in both fields of the Phase 2 network range. This will limit
you to 254 nodes.

Click the Zone List button to access the Zone List dialog box.

When Phase 1 and Phase 2 AppleTalk are both turned on, enter only
one zone in the Phase 2 EtherTalk zone list.

Specify the name of the AppleTalk zone you want to add to your
zone list and click the Add button (Figure 4-9).

GatorBox User’s Guide
August 1991



Configuring your GatorBox for AppleTalk routing

Phase 2 EtherTalk Zone list:

|Chnge| - [ Delete |

Ethertalk

Set Default

Default zone:
Ethertalk

Figure 4-11. Zone List dialog box

> If you mistype a zone name, click the misspelled zone name, make
corrections in the text box, and click the Change button.

> To remove a zone name from the list, select the zone name and
click the Delete button.

> If you click the Cancel button, GatorKeeper deletes any changes
you have made and closes the Zone List dialog box.

9. Click OK,
You will be returned to the AppleTalk Configuration dialog box.
10. Click OK.
End of min- You have completed the minimum configuration steps for Phase 1 and 2

AppleTalk routing. If you have finished configuring your GatorBox, restart
it so the changes will take effect. Refer to Restarting the GatorBox on page

imum
Phase1 &2
routin

steps 9 2-14.
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Setting up an AppleTalk tunnel

You can create AppleTalk tunnels between two or more GatorBoxes to
route AppleTalk packets through IP networks linked by IP routers.
AppleTalk packets are encapsulated and sent as IP packets.

If you are uncertain about what AppleTalk tunnels are or whether you need
m to use them, refer to Chapter 4 in the GatorBox Reference.

To create an AppleTalk tunnel between two GatorBoxes, you must
complete steps 1 through 4 for the GatorBox at each end of the tunnel:

1. Click the AppleTalk Tunnels button in the AppleTalk Routing dialog
box.

GatorKeeper displays the AppleTalk Tunnel dialog box (Figure 4-12).
The Route Type popup menu specifies the type of route to be created.

At present, only the IP to GatorBox menu selection is available. Other
options are reserved for future development.

Please designate remote AppleTalk networks...

(thange) (Delete)

Route Type

I!P to GatorBou |

IP Address of Remote GatorBox

192.55.44.10

Figure 4-12. AppleTalk Tunnel dialog box

AppleTalk Routing GatorBox User's Guide
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Configuring your GatorBox for AppleTalk routing
2. Enter the IP address of the remote GatorBox.

3. Click Add.

You can enter up to 32 remote connection points, creating 32 tunnels
from your GatorBox to other GatorBoxes.

4. Click OK.

If you have finished configuring your GatorBox, restart it so the changes will
take effect. Refer to Restarting the GatorBox on page 2-14.

may result in network numbering conflicts if networks on either side
of the tunnel use the same number. You must coordinate network
numbers for sites connected with AppleTalk tunnels to avoid number
conflicts between networks in different locations.

l. Connecting two AppleTalk networks by means of an AppleTalk tunnel

Setting up network filtering

If you have set up an AppleTalk tunnel between two GatorBoxes, you can
set up network filters to tell the GatorBox which remote AppleTalk
networks are accessible to users behind the GatorBox. By implementing
network filtering, you can restrict the remote networks (and zones) to which
users have access.

1. Click the Filtering button on the AppleTalk Routing dialog box.

GatorKeeper displays the Filter dialog box (Figure 4-13). The top
portion of the dialog box is used to specify network filters.

GatorBox User’s Guide AppleTalk Routing
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Please designate AppleTalk networks to ﬂlter‘

AppleTalk Network Number| | (Aaa ) (change) [oetete )
1250

® Listen Only to These
Remote Networks:

o) Ignore These
Remote Networks:

Please spacify NBP Flitering Options:
"0 Stay-in-2Zone Filter
[ Leser Filter
O iide Fiiter

Figure 4—13. Filter dialog box

2. Click either Listen Only to These Remote Networks or Ignore These
Remote Networks radio button:

> If you click the Listen Only to These Remote Networks radio button,
only networks behind the tunnel that are identified in the scroll box
will be known to routers and nodes on this side of the tunnel.

> If you click the Ignore These Remote Networks radio button, all
networks on the other end of the tunnel except those identified in
the scroll box will be known to routers and nodes on this side of
the tunnel.

3. Enter the number of the AppleTalk network that you are adding
to the list in the AppleTalk Network Number field.

You can add as many as 32 network numbers to the filter list. To set up
a Phase 2 EtherTalk network filter, enter the first number of the Phase
2 network range.

AppleTalk Routing GatorBox User’s Guide
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4. Click the Add button.
> If you mistypea ngtwork number, click the incorrect number in the
scroll box, correct the number when it appears in the AppleTalk
Network Number field, and click the Change button.

> If you want to remove a network number from the scroll box, click
the number and click the Delete button.

5. Click OK.

If you have finished configuring your GatorBox, restart it so the changes will
take effect. Refer to Restarting the GatorBox on page 2-14.

Specifying NBP filtering options

You can set up filters to restrict access to devices that appear in your
Chooser. There are three types of filters:

p Stay-in-Zone filters
» Laser printer filters
p Tilde filters

Instructions for setting up each filter type are provided in the sections that
follow.

Setting up Stay-in-Zone filtering

Stay-in-Zone filtering restricts users on the GatorBox’s LocalTalk network to

doing device lookups in their local zone. To set up Stay-in-Zone filtering for

your GatorBox:

1. Click the Filtering button in the AppleTalk Routing dialog box.
GatorKeeper displays the Filter dialog box (Figure 4-14).

2, Click the Stay-in-Zone checkbox.

3. Click OK.

GatorBox User’s Guide AppleTalk Routing
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If you have finished configuring your GatorBox, restart it so the changes will Q
take effect. (Refer to Restarting the GatorBox on page 2-14.)

Please designate AppleTalk netwarks to filter:

RAppleTalk Network Number:| | (hda ) (changa) [Delete )

@® Listen Only to These }2}3 Q

Remote Networks: 1360

o Ignore These
Remote Networks: 3

Please specify NBP Filtering Cptions:
"X Stoy-In-Zone Fiiter
BJd Laser Filter
O Tilde Fliter

Figure 4-14. Filter dialog box

Setting up laser printer filtering )

Laser filtering restricts users in other zones from seeing laser printers in the
LocalTalk zone. To set up laser filtering for your GatorBox:

1. Click the Filtering button in the AppleTalk Routing dialog box.
GatorKeeper displays the Filter dialog box (Figure 4-14, above).

2. Click the Laser Filter checkbox.

3. Click OK.

If you have finished configuring your GatorBox, restart it so the changes will
take effect. Refer to Restarting the GatorBox on page 2-14.

AppleTalk Routing GatorBox User’s Guide
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<w/ Setting up tilde filtering

To use tilde filtering, you must add a tilde (~) to the end of a device name

and restart the device to register its new name on the network. Tilde filtering

restricts the access to these devices in the Chooser to the local zone. To set

up tilde filtering:

1. Click the Filtering button in the AppleTalk Routing dialog box.
GatorKeeper displays the Filter dialog box (Figure 4-14, above).

2. Click the Tilde Filter checkbox.

3. Click OK.

If you have finished configuring your GatorBox, restart it so the changes will
take effect. Refer to Restarting the GatorBox on page 2-14.

Setting up KIP

(WW The GatorBox supports the KIP protocols, which encapsulate AppleTalk
packets within UDP/IP packets. UDP/IP encapsulation lets a Macintosh on
LocalTalk or EtherTalk access IP-based computers that understand

AppleTalk protocols. When KIP support is enabled, the GatorBox can
support the Columbia AppleTalk Package (CAP) software.

You do not have to enable KIP to use GatorShare.
To configure the GatorBox to support KIP encapsulation:
1. Click the KIP Options button in the AppleTalk Configuration
dialog box.
GatorKeeper displays the KIP Options dialog box (Figure 4-15).

2. Click the KIP Support (UDP Encapsulation) On radio button.

GatorKeeper displays the KIP information fields.

w
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Please Enter AppleTalk KIP Options...
KIP Support (UDP Encapsulation):
@on Oorr

KIP AppleTalk Network Number: |8158
Seed Port
KIP AppleTalk Node Number:

KIP RppleTalk Zone Name: [kiPzone |

KIP IP Network Number: [192.31.222.0 |
O Configure Using “ataikad® {3 Use New UDP Port Range (200)

Figure 4-15. KIP Options dialog box
3. Choose either seed or nonseed routing.

> Seed means that the GatorBox uses the network information as you
configured it.

> Non Seed means you don't configure the GatorBox with network
information. When the GatorBox comes up, it discovers the
network information from the atalkad server.
If you choose nonseed, you must enable atalkad, or you won’t be able
to proceed.

Figure 4-15 illustrates how you would complete the KIP Options dialog box
to reflect the atalk.local file shown in Figure 4-16.

# mynet mynode myzone

31.222 11 KIPzone

# bridgenet bridgenode bridgeIP
31.222 110 192.31.222.110

Figure 4-16. Sample atalk.local file

AppleTalk Routing GatorBox User’s Guide
4-24 August 1991



e

-

4.

7.

Configuring your GatorBox for AppleTalk routing

Enter the KIP network number in the KIP AppleTalk network number
field.

The number you enter in this field must be different from the numbers
you entered for your LocalTalk and EtherTalk networks.

If you are using CAP, this should be the same number assigned to the
bridgenet parameters in the atalk.local file on your CAP host.

If your atalk.local file expresses the bridgenet number in dotted
decimal notation, you must translate the dotted notation number into
decimal format before entering it in the KIP AppleTalk network number
field.

To translate a dotted notation number, multiply the portion of the
number preceding the decimal by 256 and add the portion of the
number following the decimal. For example, the sample atalk.local
file shown in Figure 4-16 specifies 31.222 as its mynet and bridgenet
numbers. The decimal equivalent for 31.222 is (31 x 256) + 222, or
8158. Consequently, you would enter 8158 in the KIP AppleTalk
network number field.

Enter the KIP node number in the KIP AppleTalk Node Number field.

This is the number assigned to your GatorBox on the logical KIP
AppleTalk network, and is the same as the last byte of the GatorBox IP
address. If you are using CAP, the bridgenode parameter in the
atalk.local file on your CAP host should use the same number.

Enter the zone name in the KIP AppleTalk Zone Name field.

The zone name identifies the name of the KIP network. If you are using
CAP, this should be the same name assigned to the myzone parameter
in the atalk.local file on your CAP host.

Enter the IP number in the KIP IP Network Number field.
The KIP IP network number identifies the IP network on which the CAP

host resides. Note that the KIP IP network number does not correspond
to any of the entries in the atalk.local file.
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You should enter the KIP IP network number in class C notation. For J
example, if the IP address for your CAP host is 192.20.20.6, you would
drop the last byte and enter 192.20.20.0.

8. Click the Use New UDP Port Range (200) checkbox.

Early releases of KIP used a range of UDP ports, starting at 768, to map
to the “well-known” DDP sockets. More recent releases of KIP use a
range of ports assigned by the Network Information Center that begin
at port 200. :

port range, you must add the following lines to your /etc/services

If you are using CAP and you click the checkbox to use the new UDP
AA file and specify the new port range.

at-rtmp 201/udp # AppleTalk Routing Maintenance
at-nbp 202/udp # AppleTalk Name Binding
at-echo 204/udp # AppleTalk Echo

at-zis 206 /udp # AppleTalk Zone Information

If you are using Yellow Pages (NIS), be sure to edit the services file on the
Yellow Pages master server and then remake the services database. Change
directory to /etc/yp (or /var/yp) and type make services. Q

9. Click OKifyou have finished entering the KIP parameters and are

not using atalkad. If you are going to set up atalkad, go on to step
2 in the section Setting up atalkad.

You are returned to the AppleTalk router dialog box.
10. Click OK in the AppleTalk router dialog box.

If you have finished configuring your GatorBox, restart it so the changes will
take effect. Refer to Restarting the GatorBox on page 2-14.
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Qw Setting up atalkad
To set up a GatorBox to use atalkad:
1. Click the KIP Options button in the AppleTalk Routing dialog box.
GatorKeeper displays the KIP Options dialog box (Figure 4-15).
2. Click the Configure Using “atalkad” checkbox.
The “atalkad” Server Address field appears.

3. Enter the IP address of the atalkad server in the “atalkad” Server
Address field.

4. Click OK.
You are returned to the AppleTalk router dialog box.

5. Click OK in the AppleTalk router dialog box.

ports are treated as nonseed ports when atalkad is enabled, they will also be
affected. Seed ports are not altered when you are using atalkad.

%' ‘ - Nonseed ports are affected when you are using atalkad and since soft seed

If you have finished configuring your GatorBox, restart it so the changes will
take effect. Refer to Restarting the GatorBox on page 2-14.

to use atalkad to download configuration information on the

You need to update the following files on your UNIX host if you plan
GatorBox:

» Update the atalkatab (AppleTalk administration database table) file
with information about your internet.

» Addalineto the /etc/rc.local file to start atalkad whenever the UNIX
host restarts.

» Update the atalk.local file with the AppleTalk address of the UNIX
host and the AppleTalk address of the GatorBox (or other gateway).

GatorBox User's Guide AppleTalk Routing
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Sample DECnet configuration

This chapter describes how to configure your GatorBox to perform DECnet
routing. DECnet routing allows Macintosh users on LocalTalk to
communicate with DECnet nodes on Ethernet. The GatorBox functions
according to the DECnet level 1 router specification. DECnet packets from
Macintoshes are encapsulated in AppleTalk DDP packets and forwarded to
DECnet nodes on Ethernet.

For a conceptual overview of how DECnet routing works, refer to Chapter
m 5 in the GatorBox Reference.

Sample DECnet configuration

In the sample configuration shown in Figure 5-1, GatorBox 105678 is
configured for DECnet routing. Macintosh users on LocalTalk network 1470
can then communicate with the DECnet Node 2, on the Ethernet backbone.

GatorBox User’s Guide DECnet Routing
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Default settings for DECnet routing

7 E
machine)
/ :g'ss.«z Ethermnet

182.85.44.1

B E
— machine maching )
Area hawaii paradise
Node1z / /192,31 22212 / 192.31.222.120

1muzz.m/ Amimno Ethernet
GatorBext0sE78 @- GatorBox101234 @
LocalTak 1250 182.31.241.9
LocalTak 1470 / Support zono .
/ Hyphenation zone / Moving Finger

Figure 5-1. Sample DECnet network configuration

Default settings for DECnet routing

The GatorBox has default values in place when you turn on DECnet routing.
We recommend that you use the defaults for the Hello Timer and the
Routing Timer. The default settings are listed in Figure 5-2.

DECnet Routing GatorBox User’s Guide
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Before you begin

Setting . Default value
Area 1

Node 2

Hello Timer 30

Routing Timer 120

Figure 5-2. Default DECnet routing settings

Before you begin

Before you configure your GatorBox, you need to know in which area you
are located. You also need to know your node number.

If you are not the Network Administrator, verify the area and node

' address that you plan to use with the administrator. You can cause
QW network problems if you use addresses that have been assigned to
other DECnet nodes.

Configuring your GatorBox for DECnet routing

Instructions for configuring your GatorBox are provided below. If you are
configuring multiple GatorBoxes, you must change the default node
number. You may also have to change the area number depending on your
configuration. You can follow the steps outlined in the Minimum
configuration settings section to modify the default settings. You don’t have
to make any changes on the VAX to enable DECnet routing in the GatorBox.

GatorBox User’s Guide DECnet Routing
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Configuring your GatorBox for DECnet routing

Minimum configuration settings

It's not necessary to go through every field in the DECnet Routing dialog
box. You can do a minimum configuration and be able to route DECnet
packets.

» If you are using the defaults, complete steps 1 through 4.

p If you need to change the area and node addresses, complete steps 1
through 6.

p If you are not using any of the defaults, complete all of the steps.

1 2 3

Enter the area number Enter the node Restart your

page 5-6 —_ number — GatorBox
page 5-6 page 2-14

Figure 5-3. Minimum DECnet routing configuration settings
1. Double-click the GatorKeeper icon to sﬁu’t up GatorKeeper.
2. Double-click your GatorBox icon in the GatorBoxes window.

GatorKeeper displays the Configuration Options window (Figure 5-4).

DECnet Routing GatorBox User’s Guide
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OTCcP/IP w
O AppleTalk Routing
0O GatorPrint Printers
() GatorShare Servers
0
| __ oS

Figure 5-4. Configuration options window with DECnet Routing selected

3. Double-click DECnet routing.

GatorKeeper displays the DECnet Routing dialog box (Figure 5-5).

Please configure the Decnet routing...

@ On
Qorr

Area Hello Timer

]
Node I:] Routing Timer

Figure 5-5. DECnet Routing dialog box
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Configuring your GatorBox for DECnet routing

steps

DECnet Routing

56

End of
minimum
DECnet
routing

Click the DECnet routing button On.
Enter your area number in the Area field.
Enter your node number in the Node field.

Each node number within an area must be unique.

You have completed the minimum configuration steps for DECnet routing.
If you have finished configuring your GatorBox, restart it so the changes will
take effect. Refer to Restarting the GatorBox on page 2-14.

7‘

9.

Enter a value between 1 and 8191 in the Hello Timer field.

The Hello Timer value is the interval, in seconds, between hello
messages from end nodes and from other level 1 routers. We
recommend that you use the default value of 30.

Enter a value between 1 and 8191 in the Routing Timer field.

The Routing Timer value is the interval, in séconds, between messages
sent to other level 1 routers on the network. We recommend that you

use the default value of 120.

Click OK.

If you have finished configuring your GatorBox, restart it so the changes will
take effect. Refer to Restarting the GatorBox on page 2-14.

GatorBox User’s Guide
August 1991



Chapter 6
GatorPrint Printing

This chapter will be included with the software if you
purchase GatorPrint or GatorShare.



Chapter 7
GatorShare Servers

This chapter will be included with the software if you
purchase GatorShare.
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Monitoring your GatorBox

Using the GatorDefaults file

Saving GatorBox information

Printing GatorBox information

Obtaining a crash signature

Clearing the GatorBox's configuration settings
Assigning a password to a GatorBox
Renaming a GatorBox

Obtaining GatorKeeper release information

Obtaining GatorBox software release information

If you need to call Cayman Technical Support



Monitoring your GatorBox

Monitoring your GatorBox

Monitoring your GatorBox involves checking its status, viewing statistics
that show how much memory the GatorBox is using, looking at the
diagnostics message log to view network traffic and status messages and
using TELNET to query a GatorBox.

Viewing the GatorBox Status

You can use the Status window (Figure 8-1) to review the operating status
of one or more selected GatorBoxes on your internet. To view the Status
window:

1. Double-click the GatorKeeper icon.

2. Click the GatorBox icon in the GatorBoxes window.

3. Choose the Status command from the Special menu.

Can't Find Unconfigured| Rebooting |Can't Running B
download

[

Dogzilla
O
2

Figure 8-1. Status window
GatorBox User’s Guide GatorBox Administration
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Monitoring your GatorBox

The Status window displays five columns:

vV v v v Y

Can't Find
Unconfigured
Rebooting
Can't download

Running

The meaning of each column is described in the sections that follow.

Can’t Find

Meaning:

GatorKeeper is unable to locate the GatorBox on the network.

What to do:

>

Verify that the AppleTalk connector is inserted in to the printer port (not
the modem port) of the Macintosh running GatorKeeper.

Verify that the physical connection is okay by checking the LocalTalk
connectors.

Verify that AppleTalk is active in the Chooser.

If the GatorBox is being restarted and AppleTalk routing was just turned
on, restart the Macintosh to coordinate AppleTalk network information.

Verify that no other LocalTalk network number is the same as this
GatorBox's LocalTalk network number.

If you have an Ethernet card installed in your Macintosh and you do not
have AppleTalk routing enabled on the GatorBox, verify that the
Network item in the Control Panel is set to Built-in.

GatorBox Administration ' CatorBox User’s Guide
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Unconfigured

GatorBox has not yet been configured or its configuration settings have
been cleared.

What to do:

Provide GatorKeeper with configuration information for the GatorBox
following the instructions in this manual. If the GatorBox consistently comes
up with a status of Unconfigured, contact Cayman Technical Services.

Rebooting

This is a normal state when a GatorBox first starts up. The GatorBox is either
downloading its software or reloading its configuration settings.

What to do:

This is a normal state for the GatorBox when it reboots. Wait until the icon
moves into another column to determine its state.

Can’t Download
Can’t Download only applies if you are using an original GatorBox.

Meaning:

The GatorBox is unable to download its software or its configuration
settings.

What to do:

Verify that the download server is functioning and that the GatorBox
software and configuration files are present. If that doesn't correct the
problem, refer to the manual Setting up Your GatorBox for more information
on downloading.

GatorBox User’s Guide GatorBox Administration
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Running J

GatorBox is functioning properly. If the GatorBox is a non seed router, it is
possible that its status will show as running, but it won't be routing because
it hasn't gotten seed information yet.

What to do:

No action is required.

Viewing GatorBox Statistics

The Statistics window (Figure 8-2) displays memory utilization and load

information for a specified GatorBox. For example, the bar graph at the top

of the window represents the amount of memory in use. This information

is used primarily by Cayman’s software engineering and technical support

personnel.

To view the Statistics window for a GatorBox: ;
1. Click the GatorBox icon in the GatorBoxes window.

2, Choose Statistics from the Special menu.

GatorKeeper displays the Statistics window (Figure 8-2).

</
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Monitoring your GatorBox

Statistics for Dogzilla...

Memory Statistics... Page 1

Total Hemory 2514100 bytes
Al located Memory 282390 butes

Frea Memory 2231710 bytes
32 bytes; 88 total, 20 free, 0O falled, 323 allccs
64 butes; 64 total, 16 free, O failed, 141 allocs
200 bytes; 182 total, 6 frea, O failed, 4680 allocs
690 butes: 33 total 9 free. 0 failed. 323 allocs
860 butes: 16 total, 15 frea, O failed, 1 allocs
2048 bytes; B8 total, 7 free, 0 failed, 76 allocs
4096 butes: 10 total, O free, O falled, 10 allocs
9000 bytes; 4 total 3 free, O failed, 1 allocs
System Load:

1 minute Idle 988, kernel 0%, service 1%
S minutes idle 99%, kernel 0%, service 0%
Continuous idle 988, kernal 0%, service 1%

Figure 8-2. Statistics window

3. Click on the word Page in the top right corner of the screen to
display the second page of the Statistics window.

Page two of the statistics window shows the GatorBox’s routing table
(Figure 8-2).

[[C)======== stotistics for Dogzilla.. ==

| AppleTalk Routes. .. Page 2
Networks(s) State Port Dist HNext Router
1: 15 Ok 1 1 22200.97 ¢86.184.97.1)
2: 50 Ok 1 1 22200.68 ¢86.184.08.1)>
3: 62 Ok 1 1 22200.87 ¢86.184.87.1)
4: 101- 104 Ok 1 2 22200.77 €86.184.77.1)
5: 170 Ok 1 1 22200.110 ¢86.184.110.1)
8: 207 Ok 1 1 22200.173 <B86.184.175.1)>
7. 2% Ok 1 2 22200.77 ¢B86.184.77.1)
8: 238 Ok 1 2 22200.68 ¢B6.184.08.1)
9: 239 Ok 1 2 22200,77 ¢86.184.77.1)
10: 666 Ok 1 2 22200.72 ¢86.184.72.1)
11: 710 Ok 1 1 22200.72 €86.184.72.1)
12: 829 Ok 1 1 22200.119 ¢86.184.119.1)
13: 1239 Ok 1 3  22200.77 ¢86.184.77.1>
14: 1382 Ok 1 1 22200.252 ¢86.184.232.1)
135: 1813 Ok 1 1 22200.223 ¢80.184.225.1) |
2

Figure 8-3. Statistics window - page 2

Refer to the GatorBox troubleshooting guide, GatorAid for more information
about the routing tables.

GatorBox User’s Guide GatorBox Administration
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Viewing GatorBox Diagnostics

The Diagnostics command opens the Diagnostic Messages window (Figure
8-4). The Diagnostic Messages window lets you monitor network activity
encountered by a designated GatorBox. Diagnostic messages are retained
when you close the Diagnostics Messages dialog box. As long as
GatorKeeper is running, you can close and open the Diagnostics dialog box
without interrupting the diagnostics log.

You have the option to configure the GatorBox to write the diagnostic
messages to the syslog file on a UNIX machine instead of to the Diagnostics
window. However, if you write to the syslog file, the messages will not be
logged here. The logging level is still set in this window. For instructions on
turning on the syslog option, refer to page 3-8.

Refer to the GatorBox troubleshooting guide GatorAid for a discussion of

m startup diagnostics.

The Diagnostic Messages window displays five levels of informational/error
messages: :

» Low — Low-level informational messages (L1) consist of trivial status
messages generated by the GatorBox.

» Medium — Medium-level informational messages (L2) consist of status
messages that may help monitor network traffic.

» High — High-level informational messages (L3) consist of status
messages that may be of interest to a user but that do not represent error
conditions.

» Warnings — Warning messages (L4) describe recoverable error
conditions and useful operator information.

» Failures — Failure messages (L5) describe error conditions that may
not be recoverable.

<
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Monitoring your GatorBox

To view the Diagnostic Messages window:

1. Click the GatorBox 1con in the GatorBoxes window.

2, Choose Diagnostics from the Special menu.

GatorKeeper displays the Diagnostic Messages window (Figure 8-4).

Diagnostic Messages from Dogzilla...

Reporting Level:

OLlow []Medium [X High Oon

X warnings

X Failures @lm ( setect { Clear

6/25/91 6:41
6/25/91 8:41
6/25/91 8:41:
6/25/91 8:41
6/23/91 8:41

34465,

BRRRR
GGG%0

T
ool

- W

6/25/91 0:41:34 L3
6/25/91 8:41:34 L3

PR Y. Y- T I

0 IP init completed

0 AR: RppleTalk router = Probing

: Configuring Ports

: Using Phase 2 config Inforaation

Port O Phase 2 (LocalTalk), ranges 34485-3448S,

Port O is a SOFT-SEED port

§3 23 2333

Port 1 is o NON-SEED port

: inltializing

: 802.2 port last used node id was (22200. 138)
BECnet router - Up and rumning

RR: 6802.2 port set to node €22200.133)

00000 OO0 OO0
83

0 RR: ZIP NetinfoReply (from 22200.112), ceble range -
ault zone Caribbeon

0 RR: Rdding extended port 1 seed route, netuwork

22200-22200, flags 0x300; bridge unsat

0 RR: Stwlng eonfig (nodc Id) infomotlon

ann o

PorttPheuZ(&OZ2RpploTalk20) range 0-0, net

L)

10X bytes of massages

Figure 8-4. Diagnostic Messages window

3. Click acheckbox at the top of the Diagnostic Messages window to
specify the level of messages you want to display.

Selecting messages of one level automatically selects higher level

messages as well. For example, if you select High, you will also see
Warnings and Failures.

If you select Medium or Low level messages, you may slow the
performance of the GatorBox. When the GatorBox is functioning
correctly, there is no need to set the level lower than High.

4. Click the On or Off radio button to control whether GatorKeeper
updates the messages window.

(o
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Monitoring your GatorBox

(> When the On button is clicked, the Diagnostics window continues
to scroll as new messages are received.

[> When the Off button is clicked, the window is not updated and the
messages do not scroll.

5. Click Clear to erase all of the information from the screen and
from the GatorBox’s error log file.

Using TELNET to query a GatorBox

You can TELNET to the GatorBox as a way of checking whether the box is
running. To initiate a TELNET connection, type:

TELNET <GatorBoxIPaddress>

If you assigned a password to the GatorBox, you must enter the password
before you can execute any TELNET commands.

Once the connection is open, specify the information you want to view. The
TELNET syntax for querying a GatorBox is:

help {show, status,quit, reset, reload, restart]

show [ip [arp|routes]]
[appletalk [arp|routes]|zones|interfaces]]
[share|decnet [nodes|circuits|status])
[alap]enet|log|crash|memory | dump)

status

quit

reset [alap|enet]

restart

For example, to query a GatorBox about its routes, you would enter either:
show ip routes

or
show appletalk routes.

GatorBox Administration GatorBox User’s Guide
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Using the GatorDefauits file

Other examples include:

show share displays a list of GatorShare users and the volumes they
have mounted

show alap displays the ALAP (AppleTalk Link Access Protocol) statistics
for the GatorBox

show log displays the next 25 lines of the GatorBox diagnostics
show crash displays information about the last GatorBox crash
show memory displays memory usage information for the GatorBox
show enet displays Ethernet driver statistics

reset alap clears all alap statistics

restart restarts the GatorBox

%w Using the GatorDefaults file

The GatorDefaults file stores a complete set of configuration settings for a
GatorBox. You create the GatorDefaults file the first time you run
GatorKeeper. Once you have created the GatorDefaults file, there are two
ways to configure it:

>

>

By entering settings for each field, as though it were an actual GatorBox.
If you are configuring the file as if it were an actual GatorBox, use the
instructions in the previous chapters of this manual.

By copying the settings from an already configured GatorBox.

You can use the GatorDefaults file to store configuration settings while you
test alternate settings for the GatorBox. If you wanted to restore the original
settings, copy them back from the GatorDefaults file to the GatorBox.

-
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Copying GatorBox settings to the )
GatorDefaults file

If you are copying the settings from a GatorBox to the GatorDefaults file,
complete the steps below.

1. Drag the GatorBox icon whose settings you want to use onto the
GatorDefaults icon.

2. Select Save from the File menu.

Using the GatorDefaults file to configure
GatorBoxes

Once you have set up the GatorDefaults file, you can use it to configure new
GatorBoxes rather than repeating the entire configuration process.

To use the GatorDefaults file to configure other GatorBoxes:

1. Drag the GatorDefaults icon onto the icon of the GatorBox you
want to configure. J

GatorKeeper copies the complete set of configuration information from
the GatorDefaults file to the selected GatorBox.

2. Modify the configuration settings that are unique to the
GatorBox.

network number, MaclP range, and DECnet address. Modify the

| Settings unique to each GatorBox include the IP address, LocalTalk
settings using the instructions in the previous chapters of this manual.

-

</
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Saving GatorBox information

Saving GatorBox information

You can save information about your GatorBoxes to a text file by using the
Save Info as TEXT file command in the GatorKeeper File menu. What
information is saved depends on which window or dialog box is active.

Naw N

Gpen 20
Close 8w
sSave,., R Y
Save fAs...

Page Setup...

Print... 8P
Quit 80

Figure 8-5. Save Info as Text File
If you select Save Info as TEXT file:

» While a GatorBox icon is selected, GatorKeeper saves a full description
of the GatorBox configuration information.

p While the Diagnostics window for a GatorBox is active, GatorKeeper
saves a file with the GatorBox's diagnostics information.

p While the Info window for a GatorBox is active, GatorKeeper saves a
file with the GatorBox’s firmware and software release levels, serial
number, network address, and crash information Gf available).

GatorBox User’s Guide GatorBox Administration
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Printing GatorBox information

You can print information about your GatorBoxes to any AppleTalk printer
by using the Print command in the GatorKeeper File menu.

If you select Print:

» While a GatorBox icon is selected, GatorKeeper prints a full description
of the GatorBox’s configuration.

p While the Diagnostics window for a GatorBox is active, GatorKeeper
prints the GatorBox’s diagnostics information.

» While the Info window for a GatorBox is active, GatorKeeper prints the
GatorBox’s firmware and software release levels, serial number,
network address information, and crash information (if available).

You can use the Page Setup command (from the GatorKeeper File menu)

to specify printer settings for your LaserWriter or ImageWriter, such as paper
size, page format, and reduction ratio.

Obtaining a crash signature

A crash signature is a list of the GatorBox’s registers and pointers that helps
Cayman'’s engineers determine what the GatorBox was doing when it
crashed. If your GatorBox crashes, obtain the crash signature and send it to
Cayman Technical Support by FAX or electronic mail.
To obtain a crash signature:
1. Run GatorKeeper.
2. Click the GatorBox icon in the GatorBoxes window. -
3. Pull down the Special menu and choose /nfo.

GatorKeeper displays the Information window (Figure 8-6). If crash

information for the GatorBox is available, you will see a message
(“GATORBOX HAS CRASH INFO®) at the top of the Info window.

GatorBox Administration GatorBox User’s Guide
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Obtaining a crash signature

[E0========—= Info for Dogzilla...

GATORBOX HAS CRASH INFOI

Information about GatorBox "Dogzilla”™ Iﬁ

CPU Type 68000
Model OGatorBox CS
Code in FLASH EPROM
Configuration is valid
Firmware Version 1.2

BaterSystem Version 2.0BO (build 1)
BatorShare Version 2.0B0 (build 1)
BatorPrint Yersion 2.0B0 (build 1)
DECnet Version 2.0BO (build 1)

Serial Number 100021
Ethernet Address aa-00-04-00-02-04
H/Y Rev Level 1
LocalTalk Network 10021 (0x2725)
LocalTalk Node 128 (0x80)
LocalTalk Zone Hyphenation

Figure 8-6. Information window

4.

Click the GatorBox icon in the upper right corner of the
Information window.

GatorKeeper displays the crash signature (Figure 8-7), which represents
the state of the GatorBox at the time of the crash.

Save or print the crash signature by choosing Save Info as TEXT file
or Print from the GatorKeeper File menu.

Send the crash signature to Cayman Technical Support by FAX or
electronic mail. The address is listed in If you need to call Cayman
Technical Support, page 8-19.

To clear a crash signature, select Clear from the Edit menu.

Until a crash signature is cleared, any subsequent crashes would not
leave a new signature and may go undetected.
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Clearing the GatorBox's configuration settings

El J=========— Info for Dogzilla... E

Stack

3015 0030
0000 3018
2000 00d3
b7a2 0025
dad0 00206
1858 00d3
b85e 0000

Informstion about GatorBox "Dogzilla™
Crash Signature Is "D?700*

Froma Ptrs

Last Crash PC d3b7a2, SR 2700

RO 00300002
A1 002383fb
A2 00d38e88
R3 00043dc2
A4 0025dde0
RS 00043d28
ARG 00267828
A7 00261816

DO 00000003
PARRARARREA
D2 38c4B28f
D3 0025dce?
D4 00000001
DS 0025dad0
D& 00001180
D? 0354c0cS

Figure 8-7. Crash signature

Clearing the GatorBox's configuration settings

To clear the software and configuration settings from a GatorBox:

1. Run GatorKeeper and open the GatorBoxes window.

2. Click the icon of the GatorBox whose configuration settings you
are clearing.

3. Choose the Clear command from the Edit menu.

This clears all settings for the GatorBox and causes the GatorBox to restart
and come up with a status of Unconfigured.

GatorBox Administration
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Assigning a password to a GatorBox

Assigning a password to a GatorBox

You can assign a password to a GatorBox to prevent unauthorized
modification of the GatorBox configuration files. The password is in effect
as soon as you assign it. You cannot get to any of the configuration dialog
boxes or Telnet to the GatorBox without entering the password.

Adding a password

To assign a password to a GatorBox for the first time:

1. Click the GatorBox icon in the GatorBoxes window.
2, Select Change Password from the Special menu.

GatorKeeper displays the New Password dialog box (Figure 8-8).

Please update the password:

New Password: | I

Figure 8-8. New Password dialog box
3. Enter the password for the GatorBox in the New Password field.

4. Click OK.

as you click OK. You do not have to save your changes or restart a
GatorBox to assign it a password. Make sure you type the password
correctly. You cannot change or delete the password without re-entering it,
once you click OK.

. The password you enter in the New Password field becomes effective as soon

GatorBox User’s Guide GatorBox Administration
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Changing or deleting a password </

To change a password that has been assigned to a GatorBox:

1. Select the GatorBox by clicking its icon in the GatorBoxes
window.

2. Select Change Password from the Special menu.

GatorKeeper displays the Change Password dialog box (Figure 8-9).

Please update the password:

Current Password:|

New Password: I

ok _J

Figure 8-9. Change Password dialcg box
3. Enter the current GatorBox password in the Current Password field. J
4. Enter the new GatorBox password in the New Password field.

To delete a password, leave the New Password field blank.

5. Click OK.

Renaming a GatorBox

Each GatorBox is assigned a name that includes its serial number, such as
GatorBox100019, when it is shipped to you. This name can be seen in
GatorKeeper after you connect and turn on the GatorBox.

Before you install the GatorBox, make sure the GatorBox's default name
complies with the naming conventions for your network. Also make sure
that the name and IP address of the GatorBox have been added to the
/etc/hosts file of each IP host you want to make accessible for file sharing.
Refer to NFS file server requirements on page 7-22 for instructions on editing
the hosts file. :

>
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Obtaining GatorKeeper release information

To rename the GatorBox:

1. Click the GatorBox icon in the GatorBoxes window.

2. Choose the Rename GatorBoxes command from the GatorKeeper
Special menu.

3. Enter the new name in the Rename GatorBox dialog box (Figure
8-10).

4. Click OK.

Renaming a GatorBox causes it to restart.

Rename GatorBox "gatorbon105678°

New name |Dogzilla

Figure 8-10. Rename GatorBox dialog box

Obtaining GatorKeeper release information

You can obtain information about the software release level for the version
of GatorKeeper you are running by using the About GatorKeeper dialog box
(Figure 8-11). To view the release information:

1. Pull down the Apple menu.

2. Choose About GatorKeeper.

The About GatorKeeper dialog box appears.
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Obtaining GatorBox software release information

GatorKeeper version 2.0.0 Share, Print, DECnet
Capyright 1987-91 Cayman Systems, Inc.
GaterSystem, GaterShars, GaterPriat

Figure 8-11. About GatorKeeper dialog box

Obtaining GatorBox software release information

The Info dialog box displays information about the GatorBox hardware,
firmware, and software, such as the software release levels, and Ethernet
hardware address. To view the Info dialog box:

1. Pull down the Special menu with GatorKeeper running.

2. Choose Info.

The Info dialog box appears (Figure 8-12).
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If you need to call Cayman Technical Support

[EO========= Info for Dogzille... ===

Information about GatorBox "Dogzilla®

CPU Type 68000
Model OatorBox CS
Code in FLASH EPROM
Configuration is valid

Firmware Version 1.2
BatorSystem Version 20
BatorShare Version 20
OatorPrint Version 20

Serial Number 100021
Ethernet Address 00-00-89-03-0d-6a
H/Y Rev Level 1
LocalTalk Network 0 (0xD)
LocalTalk Node 132 (0x84)
LocalTalk Zone #

Figure 8-12. Info dialog box

If you need to call Cayman Technical Support
If you have a problem with your GatorBox and you need help from Cayman
Technical Support, call us on all regular business days from 9:00 AM to 6:00
PM Eastern Time at:

Phone: (617) 494-1999

You can also reach us by:

FAX: (617) 494-5167
internet: support@cayman.com
AppleLink: CAYMAN.TECH
GatorBox User’s Guide GatorBox Administration
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If you need to call Cayman Technical Support

GatorBox Administration

8-20

Before you call

Make sure you have the following information to give to the Cayman
Support Engineer. They may ask you to fax some or all of the information
to them.

>

[

Print out your GatorBox configuration. Refer to Printing GatorBox
information, page 8-12.

Print out your GatorBox diagnostics while the problem is occurring if
possible. Refer to Viewing GatorBox Diagnostics, page 8-6.

If the GatorBox has crash information, print it out. Refer to Printing
GatorBox information, page 8-12.

Have your network diagram readily accessible.

Know the release and version numbers for the software you are using.

[> GatorBox software: GatorShare, GatorPrint, or GatorSystem
(Obtaining GatorBox software release information, page 8-18,

Obtaining GatorKeeper release information, page 8-17)

[> Other software you may be using with the GatorBox: NFS server
operating system, TOPs, etc.

Know the GatorBox hardware model and the model numbers of any
other hardware that you are using in conjunction with the GatorBox.

Know the type of Macintosh you are using and the System version
number.
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Appendix A
Configuration Checklist
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Configuration Information Checklist

TCP/IP Services

You need this information for each GatorBox you are going to configure:

GatorBox IP address
Broadcast IP address
Subnet mask

Default gateway address

KIP forwarding
First IP address in range
Number of static addresses
Number of dynamic addresses

IP subnet
LocalTalk IP address
Subnet mask
First IP address in range
Number of dynamic addresses

AppleTalk Routing

You need this information for each GatorBox you are going to configure:

LocalTalk zone number
LocalTalk zone name
LocalTalk routing type

Choose either Phase 1, 2, or 1 and 2

Phase 1 EtherTalk
EtherTalk routing type
Number
Zone name

Phase 2 EtherTalk
EtherTalk routing type
Network number range to,
Zone list

Phase 1 and 2 EtherTalk

GatorBox User’s Guide
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EtherTalk routing type
Number
Zone name -
Network number range (must be range of 1), to
Zone list
Configuration Checklist
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DECnet

You need this information for each DECnet node you are going to configure:
Area ID
Node ID

GatorPrint

You need this information for each printer you are going to configure:
Ipr name (you assign this name)

LocalTalk printer name
This is the name from the Chooser

LocalTalk printer type
(LaserWriter, ImageWriter)

Printer’s LocalTalk zone name

GatorShare J

You need this information for each server you are going to configure:
NFS Server name
NFS Server IP address

User authentication method (choose one)
Yellow Pages domain name
NFS user password file
NFS group file
penfsd

NFS Mount Point
optional (you can just use the default

AppleShare volume name

J
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Configuration Information Checklist

TCP/IP Services

"You need this information for each GatorBox you are going to configure:

GatorBox IP address
Broadcast IP address
Subnet mask

Default gateway address

KIP forwarding
First IP address in range
Number of static addresses
Number of dynamic addresses

IP subnet
LocalTalk IP address
Subnet mask
First IP address in range
Number of dynamic addresses

AppleTalk Routing

You need this information for each GatorBox you are going to configure:

LocalTalk zone number
LocalTalk zone name
LocalTalk routing type

Choose either Phase 1, 2, or 1 and 2

Phase 1 EtherTalk
EtherTalk routing type
Number
Zone name

Phase 2 EtherTalk
EtherTalk routing type
Network number range to
Zone list

Phase 1 and 2 EtherTalk
EtherTalk routing type
Number
Zone name
Network number range (must be range of 1) to
Zone list
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DECnet

You need this information for each DECnet node you are going to configure:
Area ID
Node ID

GatorPrint

You need this information for each printer you are going to configure:
Ipr name (you assign this name)

LocalTalk printer name
This is the name from the Chooser

LocalTalk printer type
(LaserWriter, ImageWriter)

Printer’s LocalTalk zone name

GatorShare J

You need this information for each server you are going to configure:
NFS Server name
NFS Server IP address

User authentication method (choose one)
Yellow Pages domain name

NFS user password file

NFS group file

pcnfsd

NFS Mount Point
optional (you can just use the default

AppleShare volume name

</
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Symbols

/etc/hosts
updating 6-3

A

about TCP/IP 3-1

AppleTalk routing
by default 4-1
configuring 4-5-4-23
creating tunnels 4-18
default values 4-4
guidelines 4-1-4-2
Phase 1 4-2
Phase 1 & 2 4-2
Phase 2 4-2
KIP & atalkad 4-27
KIP options 4-23-4-26
laser filtering 4-22
minimum configuration 4-7-4-17
network filtering 4-19
Phase 1 4-10-4-12
Phase 1 & 2 4-15-4-17
Phase 2 4-12-4-15
sample configuration 4-3
tilde filtering 4-23
tunnels '
filtering for 4-19
zone filtering 4-21

AppleTalk tunnels
creating 4-18

application disk
contents 2-3
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Index

installing 2-3
applications using TCP/IP 3-1

before you begin
TCP/IP 3-3

C

calling Cayman Support 8-19
clearing configuration 8-14

config.tel

editing 3-17
configuration

clearing 8-14

printing 8-12

saving as text 8-11
configuration application, See

GatorKeeper 1-5

configuring
AppleTalk routing 4-5-4-23
TCP/IP 3-4-3-16

crash signature
clearing 8-13
obtaining 8-12
printing 8-13
saving 8-13

Index
I-1



DECnet routing

configuring 5-3~5-6

defaults 5-3

minimum configuration 5-4-5-6
defaults

AppleTalk routing 4-4

DECnet routing 5-3
diagnostics

printing 8-12

saving as text 8-11
Diagnostics Messages window 8-7

editing config.tel file 3-17
error message levels 8-6
Ethernet hardware address, finding 8-18

G

GatorBox
adding to routing table 3-18
icons 1-3
models 1-3
restarting 2-14

GatorBox software
copying to Macintosh 24
disk contents 2-2
installing 2-4
GatorDefaults file
copying GatorBox settings to 8-10
using to configure 8-10
using to store settings 8-9

GatorKeeper
menu bar 2-7
release level, finding 8-17

Index
1-2

starting up 2-13

what is 1-5
GatorPrint, featues 1-3
GatorShare, features 1-3

guidelines, routing see AppleTalk
routing guidelines

icons, GatorBox 1-3

Info window

printing 8-12

saving as text 8-11
installation

before you begin 2-1
IP subnetting

setting up 3-12

with Telnet 3-22

KIP
setting up 3-10

MaclP parameters
entering 3-9

MacTCP
setting up 3-21
with Telnet 3-21

minimum configuration
AppleTalk routing 4-7-4-17
DECnet routing 5-4-5-6
TCP/IP 3-4-3-13

monitoring GatorBox 8-1-8-9
diagnostics 8-6
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C

statistics 8-4
status 8-1-8-4

N
NCSA Telnet

dynamic addressing 3-19
IP subnetting 3-22

MacTCP static addressing 3-21

setting up host 3-16
using 3-16-3-24

Network Applications disk
contents 2-3

P

password
adding 8-15
changing 8-16
Phase 1 & 2 routing 4-15-4-17
Phase 1 routing 4-10-4-12
Phase 2 routing 4-12-4-15
printing
configuration 8-12
crash signature 8-13
diagnostics 8-12
Info window 8-12
using 6-14-6-19

Q
querying with TELNET 8-8
R

release level
GatorKeeper, finding 8-17

GatorBox software, finding 8-18
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renaming GatorBox 8-17
restarting GatorBox 2-14

RIP
turning on 3-9

routing
default values 4-4
KIP & atalkad 4-27
KIP options 4-23-4-26
laser filtering 4-22
minimum configuration 4-7-4-17
Phase 1 4-10-4-12
Phase 1 & 2 4-15-4-17
Phase 2 4-12-4-15
tilde filtering 4-23
tunnels 4-18

filtering for 4-19

zone filtering 4-21

routing guidelines
phase 1 4-2
phase 1 & 2 4-2
phase 2 4-2

routing table, adding GatorBox to 3-18

S

saving as text
configuration 8-11
crash signature 8-13
diagnostics 8-11
Info window 8-11
software
copying to Macintosh 2-4

software files 2-2
software, GatorBox 1-4

Index
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TCP/IP
about 3-1
adding GatorBox's IP address 3-7
before configuring 3-3
configuring 3-4-3-16
entering low-level parameters 3-14
minimum configuration 3-4-3-13
parameters, entering 3-5, 3-6
sample configuration 3-2

index
1-4

telnet
dynamic addressing 3-19
IP subnetting 3-22
MacTCP static addressing 3-21
setting up host 3-16
using 3-16-3-24

TELNET, to query GatorBox 8-8
\'

viewing GatorBox status 8-1-8-4
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Reader Reply Card

Cayman is interested in learning how we can improve our documentation and
customer support. Please take a moment to complete this postage-paid survey.
Your comments are greatly appreciated.

1. How do you use this manual: (Check one or more)
O To get an overview of the product O To get out of trouble

O Tolearn a task 0O Other
O To look up a fact

2. How often do you use this:
Manual? Product?
O Daily O Weekly O Infrequently O Daily O Weekly O Infrequently

3. Is the information accurate, easy to find, and easy to read?
O Yes O No

4. Are the examples helpful and realistic?
O Yes O No

5. Are the illustrations helpful, realistic, and easy to read?
O Yes O No

6. Is the index complete and accurate?
O Yes O No

7. Did you find any errors? (Please give page numbers)

8. Did you notice any omissions? (Please give page numbers)

9. Do you have any general comments or suggestions?
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Respondent information (optional):

Name:

Company:

Address:
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Documentation

This manual was created using Microsoft Word and FrameMaker on a
Macintosh SE/30 and a Macintosh Ilci. Art was produced using Adobe
Mlustrator and Claris MacPaint. Proof pages were produced using an Apple
Personal LaserWriter. Final pages were produced using a LaserMax 1000ks
Personal Typesetter. Typefaces for this manual are Adobe Stone Sans,
Garamond, Courier, and Universal News.
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